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L3560 User's Guide
Welcome to the L3560 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Product Parts Locations
Using the Control Panel
Using Power Saving Settings
Using the Epson Smart Panel Mobile App
Voice-activated Printing
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Setting Up Printing on a Chromebook
Android Printing Using the Epson Print Enabler
Using Epson Print and Scan App with Windows Tablets
Using the Mopria Print Service

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Front and Top
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics
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Product Parts - Front and Top

1 Rear paper feeder
2 Paper support
3 Edge guide
4 Feeder guard
5 Output tray cover
6 Output tray
7 Paper stopper

Parent topic: Product Parts Locations
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Product Parts - Inside

1 Document cover
2 Scanner glass
3 Control panel

1 Inner cover
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2 Ink tank unit
3 Ink tanks
4 Ink tank cover
5 Print head

Parent topic: Product Parts Locations

Product Parts - Back

1 USB port
2 AC inlet
3 Maintenance box cover

Parent topic: Product Parts Locations

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Adjusting the Control Panel Position
Navigating the LCD Screen
Status Icon Information
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Entering Characters on the LCD Screen
Viewing Animations
Changing LCD Screen Language
Preventing PC Connection via USB
Parent topic: Product Basics

Control Panel Buttons and Lights

1 power button and light
2 LCD screen and navigation buttons

Use the arrow buttons to navigate the screen menus, then press the OK button to make a
selection.
Press back to return to the previous screen.

3 help button
4 stop button
5 start button
6 reset button
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7 home button

Parent topic: Using the Control Panel

Adjusting the Control Panel Position
You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.

Parent topic: Using the Control Panel

Navigating the LCD Screen
You can navigate the menus on the LCD screen using the arrow buttons on the control panel. To change
a setting, press the arrow buttons to highlight the setting then press the OK button to select it.
Follow these guidelines to view the menus and settings on the LCD screen.

Menu Description
Select to copy a document or photo

Select to scan a document or photo and save it to a computer
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Menu Description
Select to scan a document or photo and save it to a computer using the WSD feature

Select to change the Quiet Mode settings. When Quiet Mode is enabled, and depending
on the selected paper type and print quality, noise is reduced during printing at the cost of
print speed. To give priority to print speed, select On (Low Level).

Select to make settings related to maintenance and various other printer operations

Select to display the Help screen; you can also view instructions on common procedures
and find solutions if you experience a problem

Select to display menus for improving the quality of your printouts, such as printing a
nozzle check pattern and performing head cleaning, and aligning the print head

Select to find solutions if you experience a problem

Select to set the paper size and paper type you loaded

Select to set up the product for use on a wireless network

Parent topic: Using the Control Panel
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Related references
LCD Screen Safety Instructions
Related tasks
Copying Documents or Photos
Scanning to a Connected Computer
Scanning Using WSD - Windows
Related topics
Adjusting Print Quality

Status Icon Information
Your product displays status icons on the WiFi Setup screen for certain network status conditions.

Icons Description
The product is not connected to a wireless network

The product is searching for an SSID or experiencing a wireless network connection issue

The product is connected to a wireless network; the number of bars indicates the
connection's signal strength
Wi-Fi Direct (Simple AP) is disabled

Wi-Fi Direct (Simple AP) is enabled

Parent topic: Using the Control Panel
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Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings. Use the arrow buttons on
the control panel to navigate the on-screen keyboard, and press the OK button to select the desired
character.

• To move the cursor, select the left or right arrows.

• To change the character case or enter numbers or symbols, select A1# or press the reset button
on the control panel.

• To enter a space, select .

• To delete the previous character, select .
• Select OK, then press the OK button when you are finished entering characters.
Parent topic: Using the Control Panel

Viewing Animations
You can view animations on the LCD screen to help guide you through a procedure or troubleshoot a
problem.

1. Press the help button.
2. Select Troubleshooting if you experience a problem or How To to view instructions on common

procedures.
3. Select a topic from the list of available topics and follow the on-screen instructions.
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Parent topic: Using the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Printer Setup and press the OK button.
4. Press the arrow buttons to select Language and press the OK button.
5. Select a language and press the OK button.
6. Press the home button to exit.
Parent topic: Using the Control Panel

Preventing PC Connection via USB
You can disable access to your product from a USB-connected computer. This restricts non-network
access to the product.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Printer Setup and press the OK button.
4. Press the arrow buttons to select PC Connection via USB and press the OK button.



22

5. Select Disable and press the OK button.
6. Do one of the following:

• Press the OK button to restart the product.
• Press the stop button to return to the Printer Setup screen without restarting the product.

Note: The change will not take effect until the product is restarted.

Parent topic: Using the Control Panel

Using Power Saving Settings
Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.
Changing the Sleep Timer Setting from the Control Panel
Changing the Power Off Timer Setting from the Control Panel
Enabling the Auto Power On Setting from the Control Panel
Parent topic: Product Basics

Changing the Sleep Timer Setting from the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Printer Setup and press the OK button.
4. Press the arrow buttons to select Sleep Timer and press the OK button.
5. Use the arrow buttons to adjust the number of minutes of inactivity before the product enters sleep

mode. Then press the OK button.
6. Press the home button to exit.
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When the product enters sleep mode, the LCD screen turns black.
Parent topic: Using Power Saving Settings

Changing the Power Off Timer Setting from the Control Panel
You can use the product's control panel to change the time period before the printer turns off
automatically.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Printer Setup and press the OK button.
4. Press the arrow buttons to select Power Off Timer and press the OK button.
5. Select the length of time after which you want the product to automatically turn off when it is not in

use. Then press the OK button.

Note: Increasing the time will affect the product’s energy efficiency.

6. Press the home button to exit.
Parent topic: Using Power Saving Settings

Enabling the Auto Power On Setting from the Control Panel
You can enable the Auto Power On setting if you want the product to automatically turn on when it
receives a print job.

Note: This setting works with print jobs sent over a USB or network connection. Enabling this setting
slightly increases the product's power consumption in standby mode.

1. Make sure the power cord is plugged in and the output tray is extended.
2. Press the home button, if necessary.
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3. Press the arrow buttons to select Settings, then press the OK button.

4. Press the arrow buttons to select Printer Setup and press the OK button.
5. Press the arrow buttons to select Auto Power On and press the OK button.

Note: When Auto Power On is enabled, it may take longer to turn off the power. Make sure the
power light is off before you disconnect the power cord.

Parent topic: Using Power Saving Settings

Using the Epson Smart Panel Mobile App
Use this free Apple and Android app to set up and control your Epson product. Epson Smart Panel also
lets you check product status.

Note: App features may vary depending on your Epson product.

1. Visit latin.epson.com/connect to learn more about Epson Smart Panel and check the compatibility of
your mobile device.

2. Download Epson Smart Panel from the Apple App Store or Google Play.
3. Do one of the following:

• If your Epson product is already connected to a wireless network, connect your mobile device to
the same network. Then open Epson Smart Panel and select your Epson product, if necessary.

• If your Epson product is not connected to a wireless network, connect your mobile device to the
network you want to use, then open Epson Smart Panel and follow the instructions to set up your
Epson product.

Now you are ready to control your Epson product with your mobile device.
Parent topic: Product Basics

https://latin.epson.com/connect


25

Related topics
Wi-Fi Networking

Voice-activated Printing
Take advantage of voice-activated, hands-free printing from your Epson product with Alexa. You can ask
your product to print photos, calendars, photo props, and more. Click here for more information.
1. Connect your product to your network. See the link below.
2. Set up your product's email address for use with Epson Connect. If you did not already set up an

Epson Connect account when you installed your product software, visit epsonconnect.com to create
your account and register your product to the Epson Connect service.

3. Click here for instructions on how to set up your product and voice assistant to use the voice-
activated printing feature.

Now you are ready to print with your voice and your Epson product.
Parent topic: Product Basics
Related tasks
Setting Up Epson Connect Services
Using the Epson Smart Panel Mobile App
Related topics
Wi-Fi Networking

Epson Connect Solutions for Smartphones, Tablets, and More
Use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your
home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Print from anywhere with these Epson Connect solutions:
• Epson Email Print
• Epson Remote Print
Setting Up Epson Connect Services

https://latin.epson.com/support/voice
https://www.epsonconnect.com/
https://latin.epson.com/support/voice
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Using Epson Email Print
Using Epson Remote Print
Parent topic: Product Basics
Related tasks
Setting Up Printing on a Chromebook
Using AirPrint
Android Printing Using the Epson Print Enabler
Using Epson Print and Scan App with Windows Tablets
Using the Mopria Print Service

Setting Up Epson Connect Services
If you did not activate your product's email address for use with Epson Connect when you set up your
product, you can activate it using the product control panel.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Epson Connect Services and press the OK button.
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You see this screen:

4. Press the OK button to select Register/Delete.
5. Press the OK button to select Yes.
6. Follow the instructions on your screen to activate your product's email address.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi Networking

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.
1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below

to use your product control panel to activate your unique email address. Or visit epsonconnect.com
to learn more about Email Print, create your Epson Connect account, and register your product to
the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

https://www.epsonconnect.com
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Note: Go to epsonconnect.com and log into your Epson Connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related tasks
Setting Up Epson Connect Services
Related topics
Wi-Fi Networking

Using Epson Remote Print
With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.
1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software,

visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer

application and choose the Remote Print option for your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related tasks
Setting Up Epson Connect Services
Related topics
Wi-Fi Networking

http://www.epsonconnect.com
http://www.epsonconnect.com
http://www.epsonconnect.com
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Using AirPrint
AirPrint enables instant wireless printing from iPhone, iPad, iPod touch, and Mac without the need to
install drivers or download software.

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
Related references
Paper Source Settings Options
Related topics
Wi-Fi Networking
Loading Paper

Setting Up Printing on a Chromebook
Your Epson printer supports native printing on Chromebook, allowing you to print from a Chromebook
without drivers or cables.
For directions on setting up your printer, visit the Setting Up Your Epson Printer on Your Chromebook
site.
Parent topic: Product Basics

https://latin.epson.com/support/wa00901
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Related topics
Wi-Fi Networking

Android Printing Using the Epson Print Enabler
You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.

Note: Operations may differ depending on the device.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu

icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics
Related topics
Wi-Fi Networking

Using Epson Print and Scan App with Windows Tablets
You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface
RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and
capture images right to your tablet or Microsoft OneDrive.

Note: The Epson Print and Scan app does not support Windows 10 Mobile printing and does not supply
scanning functions for products without scanners.

1. Connect your Epson product to your wireless network. See the link below.
2. Download the Epson Print and Scan app from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
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4. Open the Epson Print and Scan app and select your Epson product.
Now you are ready to print photos or scan.

Parent topic: Product Basics
Related topics
Wi-Fi Networking

Using the Mopria Print Service
You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here. Some Amazon Fire tablets also use the Mopria
Print Service.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service app from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service, if
necessary.

4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu

icon and select Print. Then select All printers, select your Epson product, adjust your print settings,
and print.

Parent topic: Product Basics
Related topics
Wi-Fi Networking

https://latin.epson.com/epson-connect-wireless-printing-partner-solutions?pg=7#sn
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Wi-Fi Networking
See these sections to use your product on a Wi-Fi network.
Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations
To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.
Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:
• Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

• Connect your product only to a network protected by a firewall
Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has the option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Wi-Fi Infrastructure Mode Setup
You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel
Parent topic: Wi-Fi Networking
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Selecting Wireless Network Settings from the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup, then press the OK button.

3. Press the OK button to select Wi-Fi (Recommended), then press the OK button again.
4. Press the OK button to select Wi-Fi Setup Wizard, then press the OK button again.
5. Press the arrow buttons to select the name of your wireless network and press the OK button. If you

do not see your wireless network's name, press the reset button to refresh the list. If it is still not
displayed, you can enter it manually.

Note: To enter the wireless network name manually, select Other SSIDs and press the OK button.
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6. Enter your wireless password (or network name and then password).

Note: Use the arrow buttons on the control panel to navigate the on-screen keyboard, and press the
OK button to select the desired character. The network name and password are case sensitive. Be
sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

• To move the cursor, select the left or right arrows.

• To change the character case or enter numbers or symbols, select A1# or press the reset
button on the control panel.

• To enter a space, select .

• To delete the previous character, select .
• When you are finished entering characters, select OK and press the OK button.

7. If you want to print a network connection report, press the start button. (Otherwise, press the
stop button.)

8. Press the home button to return to the Home screen.

The Wi-Fi icon displayed on the WiFi Setup screen indicates your wireless connection status. If
the product is not connected to the network, you may have selected the wrong network name or
entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup
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Related references
Status Icon Information
Related tasks
Entering Characters on the LCD Screen

Wi-Fi Direct Mode Setup
You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to 8 devices.

1 Epson product
2 Computer with a wireless interface
3 Other wireless device

Enabling Wi-Fi Direct (Simple AP) Mode
Parent topic: Wi-Fi Networking

Enabling Wi-Fi Direct (Simple AP) Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and computer,
mobile devices, or other devices (up to 8) without a wireless router or access point.

Note: Make sure the Epson Smart Panel app or another compatible Epson printing app is installed on
your mobile device before connecting to the product.
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1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup, then press the OK button.

3. Press the arrow buttons to select Wi-Fi Direct and press the OK button.
4. Press the OK button twice.
5. Do one of the following:

• Open the Epson Smart Panel app on your device, then press the down arrow button on your
product's control panel to view the product information. Use the information on the product's LCD
screen to select your product in the Epson Smart Panel app. Skip to step 7.

• To connect without using the Epson Smart Panel app, press the left arrow button to select Other
Methods and go to the next step.

6. Do one of the following:
• For iOS devices, select iOS. Press the OK button, then scan the QR code with the camera app on

your device and follow the instructions on your device.
• For other types of devices, select Other OS Devices. Press the down arrow button to display the

product information, then use your device to select the Wi-Fi network name (SSID) displayed on
the LCD screen and enter the password shown.

7. Press the OK button to exit.

The Wi-Fi Direct icon displayed on the Wi-Fi Setup screen indicates if Wi-Fi Direct is enabled
on the product. If your device is not connected, repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup
Related references
Status Icon Information
Related tasks
Using the Epson Smart Panel Mobile App
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Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the device's software. Check
your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network
If you have a WPS-enabled router or access point, you can use Wi-Fi Protected Setup (WPS) to connect
your product to the network.
1. Press the WPS button on your router.
2. On the product, press the home button, if necessary.
3. Press the arrow buttons to select Wi-Fi Setup, then press the OK button.

4. Press the OK button to select Wi-Fi (Recommended), then press the OK button again.
5. Press the OK button again.
6. Press the arrow buttons to select Push Button Setup (WPS) and press the OK button.
7. Follow the instructions on the LCD screen to complete WPS setup.

The Wi-Fi icon is displayed on the Wi-Fi Setup screen and indicates your wireless connection
status. If the product is not connected to the network, repeat these steps to try again.

Parent topic: Wi-Fi Protected Setup (WPS)
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Related references
Status Icon Information

Printing a Network Status Sheet
You can print a network status sheet for detailed information about your product's network status.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Network Settings and press the OK button.
4. Select Print Status Sheet and press the OK button.
5. Press the start button to print the network status sheet.

If you want to cancel the operation, press the stop button.
Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi Networking
Related topics
Loading Paper

Printing a Network Connection Report
You can print a network connection report to view solutions to any problems you may have using your
product on a network.
1. Press the home button, if necessary.
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2. Press the arrow buttons to select Settings, then press the OK button.

3. Press the arrow buttons to select Network Settings and press the OK button.
4. Select Connection Check and press the OK button.
5. Press the start button to print the network connection report.
Examine any error codes and solutions shown on the network connection report.
Network Connection Report Codes and Messages
Parent topic: Wi-Fi Networking
Related topics
Loading Paper

Network Connection Report Codes and Messages
Check the error codes and messages on the network connection report to solve problems you may
encounter with network connections. The tables here list solutions to problems based on the error codes
and messages that may appear at the top of the report.
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1 Error code
2 Message

Note: Error codes and messages listed here may not all apply to your product.

Error Codes and Messages

Error code and message Solution
E-1
Confirm that the network cable is
connected and network devices such as a
hub, router, or access point are turned on.

Make sure your router, access point, and/or hub are
turned on, and the network cable is securely connected to
your device and your product.
If you are trying to set up Wi-Fi, remove the network cable
and set up Wi-Fi again. Ethernet and Wi-Fi cannot be
connected at the same time.
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Error code and message Solution
E-2, E-3, or E-7
No wireless network names (SSID) found.
Confirm that the router/access point is
turned on and the wireless network (SSID)
is set up correctly. Contact your network
administrator for assistance.
No wireless network names (SSID) found.
Confirm that the wireless network name
(SSID) of the PC you wish to connect is set
up correctly. Contact your network
administrator for assistance.
Entered security key/password does not
match the one set for your router/access
point. Confirm security key/password.
Contact your network administrator for
assistance.

Check the following:
• Make sure your router or access point is turned on and

is correctly connected to your computer or network
device.

• Turn off the router or access point, wait about 10
seconds, and turn it on again.

• Move your product closer to your router or access point,
and remove any obstacles between them. Also move
your product away from devices such as wireless
phones or microwaves.

• Confirm that the SSID shown on the network
connection report matches the label on your router or
access point. Also make sure your SSID uses only
ASCII characters and symbols, or your product cannot
display the SSID correctly.

• If you are trying to connect using the WPS push button
method, make sure your router or access point supports
it.

• If you are using a network password, check the label on
your router or access point to confirm that you are using
the correct password, or check with your network
administrator or router/access point documentation.

• If you are connecting to a smart device that generates
an SSID, check the device documentation for the SSID
and password you should use.

• If your wireless connection suddenly disconnects, and
another smart device was added to the network using a
WPS push button method, or your network was set up
using a non-WPS push button method, try downloading
and installing your product software again.
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Error code and message Solution
E-5
Security mode (e.g. WEP, WPA) does not
match the current setting of the printer.
Confirm security mode, and contact the
network administrator for assistance.

If the security on your router or access point is not one of
the following types, change the type of security on your
router or access point and reset your product's network
settings.
• WEP-64 bit (40 bit)
• WEP-128 bit (104 bit)
• WPA PSK (TKIP/AES); also known as WPA Personal
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal
• WPA (TKIP/AES)
• WPA2 (TKIP/AES)
• WPA3-SAE (AES)
Also make sure you are connecting to the 2.4GHz band
on your network and using the password for that band.

E-6
MAC address of your printer may be
filtered. Check whether your router/access
point has restrictions such as MAC address
filtering. See the documentation of the
router/access point or contact your network
administrator for assistance.

If your router or access point has MAC address filtering
enabled, register your product's MAC address so it is not
filtered. Locate the MAC address on the network
connection report and check your router or access point
documentation for instructions.
If your router or access point is using shared
authentication with WEP security, confirm that you are
using the correct authentication key and index.
If your router or access point limits the number of
connected devices, raise the connection limit. See your
router or access point documentation for instructions.

E-8
Incorrect IP address is assigned to the
printer. Confirm IP address setup of the
network device (hub, router, or access
point). Contact your network administrator
for assistance.

If your product's Obtain IP Address setting is set to Auto,
enable DHCP on your router or access point. If it is set to
Manual, the IP address may be out of range or on a
different network segment; set a valid IP address using
your product control panel or the Web Config utility.
You can also try turning off your product and the router or
access point, waiting about 10 seconds, and turning them
on again.
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Error code and message Solution
E-9
Confirm the connection and network setup
of the PC or other device. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure your computer or network device are turned
on. Also make sure that you can access the Internet and
other devices on the same network from the devices you
are trying to connect to your product.
If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again. Download and install your product software
again to reset your network settings.

E-10
Confirm IP address, subnet mask, and
default gateway setup. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure other devices on the network are turned on and
do the following:
• If your product's Obtain IP Address setting is set to

Manual, check the IP address, subnet mask, and
default gateway addresses on the network connection
report to see if they are correct. If not, correct the
settings.

• If DHCP is enabled, set your product's Obtain IP
Address setting to Auto. If you want to use the DHCP-
assigned address as a static address, set the Obtain IP
Address setting to Manual, enter the product's IP
address as listed on the network connection report, and
set the subnet mask to 255.255.255.0.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again.

E-11
Setup is incomplete. Confirm default
gateway setup. Connection using the
EpsonNet Setup is available. Contact your
network administrator for assistance.

If you set your product's TCP/IP Setup setting to Manual,
check that the default gateway address listed on the
network connection report is correct. Also turn on the
device that is set as the default gateway.



45

Error code and message Solution
E-12
Confirm the following:
-Entered security key/password is correct
-Index of the security key/password is set to
the first number
-IP address, subnet mask, or default
gateway setup is correct
Contact your network administrator for
assistance.

Make sure other devices on the network are turned on and
do the following:
• Make sure the IP address, subnet mask, and default

gateway addresses are correct, if you are entering them
manually.

• Confirm that the subnet mask and default gateway
addresses for other devices are the same.

• Make sure the IP address does not conflict with other
devices.

If you still cannot connect to your product, do the
following:
• Turn off your router or access point, wait about 10

seconds, and turn it on again.
• Download and install your product software again to

reset your network settings.
• If your router or access point uses WEP security with

several registered passwords, make sure that the first
registered password is set on your product.

E-13
Confirm the following:
-Entered security key/password is correct
-Index of the security key/password is set to
the first number
-Connection and network setup of the PC
or other device is correct
Contact your network administrator for
assistance.

Make sure your router, access point, and/or hub are
turned on. Also make sure the TCP/IP setup on your
router, access point, and/or hub is not set manually; this
may cause your product's network settings to differ from
the manually set up devices.
If you still cannot connect to your product, do the
following:
• Turn off your router or access point, wait about 10

seconds, and turn it on again.
• Download and install your product software again to

reset your network settings.
• If your router or access point uses WEP security with

several registered passwords, make sure that the first
registered password is set on your product.
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Network Environment Messages

Message Solution
The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

Move your product closer to your router or access point,
and remove any obstacles between them. Then turn off
your router or access point, wait about 10 seconds, and
turn it back on again. If you still cannot connect to your
product, check the documentation that came with your
router or access point for solutions.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

You can connect up to 8 computers or other devices to
your product using a Wi-Fi Direct (Simple AP) connection.
If you want to add another device, disconnect an existing
connected device first.

The same SSID as Wi-Fi Direct exists in
the environment. Change the Wi-Fi Direct
SSID if you cannot connect a smart device
to the printer.

Change the Wi-Fi Direct SSID.

Parent topic: Printing a Network Connection Report

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.
Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: You can also access the Web Config utility from the product information area in the Epson Smart
Panel app.
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1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web

browser.
4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.

Note: The administrator password is required to access the full capabilities of the Web Config utility. The
default password is the product's serial number. Check the label on your product to locate the serial
number.

Parent topic: Changing or Updating Network Connections
Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the

Start Here sheet.
Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software

Connecting to a New Wi-Fi Router
If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation for instructions.
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1. Do one of the following:
• Windows: Uninstall your product software.
• Mac: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup, then press the OK button.

3. Press the arrow buttons to select either Wi-Fi (Recommended) or Wi-Fi Direct and press the OK
button.

4. Do one of the following:
• If you selected Wi-Fi (Recommended), press the OK button, press the arrow buttons to select

Others, and press the OK button again. Press the arrow buttons to select Disable Wi-Fi and
press the OK button.

• If you selected Wi-Fi Direct, press the OK button twice. Press the reset button to display the
setting screen, press the arrow buttons to select Disable Wi-Fi Direct, and press the OK button
again.
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Note: When the Wi-Fi Direct (Simple AP) connection is disabled, all computers and smart devices
connected to the product in Wi-Fi Direct (Simple AP) mode are disconnected. If you want to
disconnect a specific device, disconnect from the device instead of the product.

5. Press the OK button to disable your product's Wi-Fi features.
Parent topic: Changing or Updating Network Connections
Related references
Status Icon Information
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in the Rear Paper Feeder
Compatible Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings - Control Panel
Selecting the Default Paper Source Settings

Loading Paper in the Rear Paper Feeder
You can print documents and photos on a variety of paper types and sizes.
1. Flip the feeder guard forward then pull out the paper support.

2. Slide the edge guides out all the way.
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3. If you are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even
the edges.

Note: Do not fan or curl photo paper.

4. Do one of the following:
• Insert paper, glossy or printable side up and short edge first, in the center of the paper support.

• Load up to 10 envelopes in the center of the rear paper feeder. Load them printable side up, short
edge first, and flap facing down.
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• Load a sheet of loose-leaf or other paper with holes facing as shown.

• To load a sheet of paper longer than legal size, close the paper support and flatten the leading
edge of the paper as shown. Select User-Defined as the paper size setting.

5. Slide the edge guides against the paper, but not too tightly. Then flip the feeder guard back.

Note: Do not place objects on the feeder guard. Doing so may prevent paper from feeding.
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6. Open the front cover, then pull out the output tray and open the paper stopper.

7. If prompted by the product's LCD screen, select one of the following:
• If the displayed paper settings match the loaded paper, select Confirm and press the OK button.
• If the displayed paper settings differ from the loaded paper, select Change, select the size and

type of the paper you loaded, and press the OK button.

Note: If you do not want to display the paper settings screen automatically when you load paper,
select Settings > Printer Setup > Paper Source Settings > Paper Setup Auto Display > Off. If
you disable this setting, you cannot use AirPrint.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first. You can load paper long edge first only if you have selected the User-

Defined paper size setting and set the width of the paper as the size of the long edge.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guides.
• If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on

curled paper may cause paper jams and smears on the printout.
• Do not use papers that are wavy, torn or cut, folded, damp, have stickers, or are too thick or too thin.
• Fan and align the edges of paper and envelopes before loading. Do not fan or curl photo paper.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• Do not load envelopes that are curled, folded, or too thin, or that have plastic windows or exposed

adhesive flaps.
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• Paper feed problems may occur frequently for manual 2-sided printing when printing on one side of
pre-printed paper. Reduce the number of sheets to half or less, or load one sheet of paper at a time if
paper jams continue.

• For pre-punched paper, load a single sheet of defined-size plain paper with holes at the left or right.
Adjust the print position of your file to avoid printing over the holes.

• For paper longer than Legal size, make sure the end of the paper is cut perpendicularly. A diagonal
cut may cause paper feed problems. Long paper cannot be held in the output tray. Prepare a box or
tray to make sure that paper does not fall on the floor. Do not touch paper that is being fed or ejected.
It could injure your hand or cause print quality to decline.

• Return unused paper to its packaging to avoid curling or reduction in print quality.
• Check the paper package for any additional loading instructions.
• Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check

the paper packaging or contact the manufacturer to confirm the paper specifications.
• To achieve high-quality printouts with genuine Epson paper, use the paper in the environment stated

on the instructions supplied with the paper.
Paper Loading Capacity
Borderless Paper Type Compatibility
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Printable Area Specifications
Paper Specifications

Paper Loading Capacity
See the table here for the loading capacity of the rear paper feeder. Epson recommends using genuine
Epson paper to ensure high-quality printouts.

Note: The availability of paper varies by location. For the latest information on paper available in your
area, contact Epson support.
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Paper type Loading capacity Manual double-sided capacity
Plain paper
Copy paper

Available paper sizes*
Letter (8.5 × 11 inches
[216 × 279 mm]) or A4
(8.3 × 11.7 inches
[210 × 297 mm]) or smaller: Up
to the line indicated by the
arrow mark

30 sheets

Available paper sizes*
Oficio 9 (8.46 × 12.4 inches
[215 × 315 mm]) or 8.5 × 13
inches (216 × 330 mm) or
larger: 1 sheet

1 sheet

Epson Presentation Paper Matte
Epson High Quality Ink Jet Paper

80 sheets —

Epson Premium Presentation
Paper Matte
Epson Photo Paper Glossy
Epson Premium Photo Paper
Glossy
Epson Ultra Premium Photo
Paper Glossy
Epson Premium Photo Paper
Semi-gloss
Epson Value Photo Paper Glossy

20 sheets
If paper feeds incorrectly, or
printing is uneven or smeared,
load 1 sheet at a time.

—

Epson Premium Presentation
Paper Matte Double-sided

1 sheet 1 sheet

Envelopes 10 envelopes —

* Select the paper specification link below to view the list of available paper sizes.
Parent topic: Loading Paper in the Rear Paper Feeder
Related references
Paper Specifications
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Borderless Paper Type Compatibility
You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
• Epson Value Photo Paper Glossy
• Epson Photo Paper Glossy
• Epson Premium Photo Paper Glossy
• Epson Ultra Premium Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss

Borderless Paper Sizes
• 3.5 × 5 inches (89 × 127 mm)
• 4 × 6 inches (102 × 152 mm)
Parent topic: Loading Paper in the Rear Paper Feeder

Compatible Epson Papers
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.

Note: Paper/media availability varies by country.

Paper Type Size Part number Sheet count
Epson Presentation Paper Matte Legal (8.5 × 14 inches

[216 × 356 mm])
S041067 100

Epson Premium Presentation
Paper Matte

8 × 10 inches (203 × 254 mm) S041467 50
Letter (8.5 × 11 inches
[216 × 279 mm])

S041257-ML 50

Epson High Quality Ink Jet Paper A4 (8.3 × 11.7 inches
[210 × 297 mm])

S041117 100

Letter (8.5 × 11 inches
[216 × 279 mm])

S041111 100

https://latin.epson.com
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Paper Type Size Part number Sheet count
Epson Premium Presentation
Paper Matte Double-sided

Letter (8.5 × 11 inches
[216 × 279 mm])

S041568 50

Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809
S042038

50
100

Letter (8.5 × 11 inches
[216 × 279 mm])

S041141
S041271

20
100

A4 (8.3 × 11.7 inches
[210 × 297 mm])

S041140 20

Epson Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S041808
S041727

40
100

5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches
[216 × 279 mm])

S041286-ML
S042183
S041667

20
25
50

Epson Ultra Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S042181
S042174

60
100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches
[216 × 279 mm])

S042182
S042175

25
50

Epson Premium Photo Paper
Semi-gloss

4 × 6 inches (102 × 152 mm) S041982 40
Letter (8.5 × 11 inches
[216 × 279 mm])

S041331-ML 20
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Paper Type Size Part number Sheet count
Epson Value Photo Paper Glossy Letter (8.5 × 11 inches

[216 × 279 mm])
S400031 50

4 × 6 inches (102 × 152 mm) S400032
S400033
S400034

20
50
100

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software
For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper / Bright White Paper
Envelopes Envelope
Epson Ultra Premium Photo Paper Glossy
Epson Value Photo Paper Glossy

Ultra Premium Photo Paper Glossy

Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Presentation Paper Matte Presentation Paper Matte
Epson Premium Presentation Paper Matte
Epson High Quality Ink Jet Paper
Epson Premium Presentation Paper Matte Double-
sided

Premium Presentation Paper Matte

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper
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Selecting the Paper Settings - Control Panel
You can change the default paper size and paper type using the control panel on the product.

Note: These settings appear automatically when paper is inserted when you have set the Paper Setup
Auto Display setting to On.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Select Printer Setup > Paper Source Settings > Paper Setting and press the OK button.
4. Select Paper Size.
5. Select the paper size you loaded.
6. Select Paper Type.
7. Select the paper type you loaded.
8. Press the home button to exit.
Paper or Media Type Settings - Control Panel
Parent topic: Loading Paper

Paper or Media Type Settings - Control Panel

For this paper Select this Paper Type setting
Plain paper Plain Paper
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Ultra Premium Photo Paper Glossy
Epson Value Photo Paper Glossy

Ultra Glossy
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For this paper Select this Paper Type setting
Epson Photo Paper Glossy Glossy
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Presentation Paper Matte Presentation Matte

Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided
Epson High Quality Ink Jet Paper

Prem. Matte

Envelope Envelope

Parent topic: Selecting the Paper Settings - Control Panel

Selecting the Default Paper Source Settings
You can change default paper source settings using the control panel on the product.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings, then press the OK button.

3. Select Printer Setup > Paper Source Settings and press the OK button.
4. Select the options you want to use.
5. When you are finished, press the home button to exit.
Paper Source Settings Options
Parent topic: Loading Paper

Paper Source Settings Options
Select the paper source options you want to use for your print jobs.
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Paper Source
Settings option

Available settings Description

Paper Setting Various Select the paper size and type for each paper source
A4/Letter Auto
Switching

On Select On to switch the selected paper size to match the
loaded paper (Letter or A4) if the wrong size is selectedOff

Error Notice Paper Size Notice Select On for either of these settings to display an error
message when the selected paper type or size does not
match the loaded paperPaper Type Notice

Paper Setup
Auto Display

On Select On to automatically display a menu that lets you
select the paper size and type when you load paper in the
product.

Note: If this setting is disabled, you cannot print from an
iPhone, iPad, or iPod touch using AirPrint.

Off

Parent topic: Selecting the Default Paper Source Settings
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or
A4 (8.3 × 11.7 inches [210 × 297 mm]).

Note: To view animated instructions on how to place originals on the scanner glass, press the help
button and select How To > Place Originals > Scanner Glass.

1. Open the document cover.

Caution: Be careful not to trap your hands or fingers when opening or closing the document cover.
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Note: If there is any dust or dirt on the scanner glass, the scanning range may expand to include it,
so the image of the original may be displaced or reduced. Use a soft, dry, clean cloth to remove any
dust and dirt on the scanner glass before scanning.

2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: If you are using Epson ScanSmart to scan multiple photos at once, just make sure they are at
least 0.2 inch (4.5 mm) away from the edge of the scanner glass and at least 0.8 inch (20 mm) away
from each other.

Note: When placing bulky originals such as books, prevent exterior light from shining directly onto
the scanner glass.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the
product.

Warning: Be careful not to trap your hands or fingers when closing the document cover or you may
be injured.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they
may stick to the glass surface.
Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
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Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying Options

Copying Documents or Photos
You can copy color or black-and-white documents or photos onto various sizes and types of paper,
including Epson special papers.
1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on.
3. Press the home button, if necessary.
4. Press the arrow buttons to select Copy, then press the OK button.

5. Press the left or right arrow button to select one of the following:
• Color: for color copies
• B&W: for black-and-white copies

6. To print more than one copy, press the up or down arrow button to adjust the number (up to 99).
7. Press the OK button to view the print settings for the copies.
8. Press the down arrow button to view the individual settings.
9. To change the print settings, use the arrow buttons to select and adjust the necessary settings.

When you are finished, press the OK button.
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10. When you are ready to copy, press the start button.

Note: The color, size, and border of the scanned image will not be exactly the same as the original.
To cancel printing, press the stop button.

Parent topic: Copying
Related references
Copying Options
Compatible Epson Papers
Related topics
Loading Paper
Placing Originals on the Product

Copying Options
Select the copying options you want to use for your copies. You can access these settings by selecting
Copy > More on the home screen.

Note: Not all options or settings may be available, depending on other copying settings.

Print Settings

Copying option Available settings Description
Density Varying levels Adjust the lightness or darkness of copies
Paper Setting Paper Size Select the paper size

Paper Type Select the paper type
Reduce/Enlarge Actual Size Copies the original at its full size

Auto Fit Automatically sizes the image to fit the paper size you
selected

Custom 100% and
other conversions

Copies the original at 100% unless you change the amount
by adjusting the Custom Size setting

Custom Size 25 - 400 in 1%
increments

Adjust the amount to re-size the original
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Copying option Available settings Description
Original Size Various sizes Select the document size of your original. When copying

non-standard size originals, select the size closest to your
original.

Multi-Page Single Page Copies each page of the original onto an individual sheet
2-up Copies two single-sided originals onto one sheet. Scroll

down and select the document orientation and layout order
settings as necessary.

Quality Standard Adjusts the quality of your copies; selecting High provides
higher quality printing, but the printing speed may be slower.High

ID Card Copy Off Select On to copy both sides of an ID card onto one side of
a sheet of paperOn

Borderless Copy Off Copies the original without margins around the edges. The
image is enlarged a little to remove margins from the edges
of the paper. Select On to adjust the amount to expand the
original when printing borderless copies.

On
Standard
Medium
Minimum

Parent topic: Copying
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions. You can also check for updates using Epson Software Updater in the Epson
software folder on your computer.

Note: Your printer driver settings may differ slightly from the settings listed here until you update your
printer driver to the latest version.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Printing from a Smartphone or Tablet
Printing with Epson Photo+
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Checking Print Status - Windows
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Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.

Note: The available settings and appearance of the print window may differ slightly from those covered
here, depending on the Windows version and the application you are using.

1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see the Main tab of your printer settings window:

4. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size, but you cannot
use the Borderless setting and the Quality setting will be set to Standard.

5. Select the Borderless checkbox if you want to print a borderless photo. If you don't see the
checkbox, change the Paper Type setting to a paper type that supports borderless printing. You can
click Settings to access additional options for borderless printing.

Note: Check the borderless paper compatibility list for details.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.
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7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

10. To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
15. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the

Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references
Paper or Media Type Settings - Printing Software
Borderless Paper Type Compatibility
Related tasks
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Printing Your Document or Photo - Windows
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Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
Draft - Vivid

For draft printing on plain paper with good quality and print speed.
Standard

For everyday text and image printing.
Standard - Vivid

For text and graphics with good quality and print speed.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

Note: This feature is not available with 2-sided printing.

2-Up, 4-Up, 6-Up, 8-Up, 9-Up, and 16-Up
Prints several pages on one sheet of paper. Click the Layout Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.
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Note: This feature is not available for borderless printing.

Note: You will need to print one side and flip the paper over manually to print the other side.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
• Manual (Long-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the long edge to print the other side.
• Manual (Short-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the short edge to print the other side.
2. Click the Settings button.
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You see a window like this:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.
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Note: The surface of the paper may smear during double-sided printing. Make sure the ink has dried
before reloading the paper.

Double-sided Printing Options - Windows
Parent topic: Printing with Windows
Related references
Paper Loading Capacity
Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
Binding Margin Options

Select options that define a wider margin to allow for binding.
Booklet Option

Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.
Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output Paper
setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
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• Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.

Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:
• Anti-Copy Pattern: adds a watermark that only appears when your printout is copied

Note: This setting is not available for all types of printing. Click the Add/Delete button to create
your own pattern, and click the Settings button to customize the pattern.

• Watermark: adds a visible watermark to your printout

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
Related tasks
Printing Your Document or Photo - Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.
Print Text in Black

Prints colored text in black.
For Color Text

Prints colored text on a background pattern or underlined.
For Color Graphs and Images

Prints colored graphics and images with overlay patterns.
For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.
Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
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Bidirectional Printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print
quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.
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You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Document Name
• Collate Number (copy number)
• Page Number
• Text
You can also adjust the text settings for the printed information.

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings or delete it, or use any of the available options on the screen

to control your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.
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Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.

You see the maintenance options:

4. Click the Extended Settings button.
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You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Short Grain Paper

Prevents ink from smearing when you print on envelopes or other thick paper.
Separator Page

Before each document, prints a separator page containing the title, user, date, and time.
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Remove white borders
Removes white margins that may appear when you print borderless photos.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Reduce Print Data Size
Increases print data compression to improve print speed. Not recommended when printing fine
patterns.

Use a Mixture of Color Inks to Create Black
Mixes color inks to create composite black when printing at standard quality on plain paper or
envelopes.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
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Checking Print Status - Windows
During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink status.

• To cancel printing, click Cancel.
• To see print jobs lined up for printing, click Print Queue.
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• To close the status window, click OK.
• To check ink status, click Consumables Status.
Parent topic: Printing with Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
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You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
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You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
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Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see a window like this:
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4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

5. Click the Advanced button.
You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.



93

10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

13. Click OK to save your settings.
You see your application's Print window.

14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software

Printing on a Mac
You can print with your product using any Mac printing program, as described in these sections.
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Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website or using Epson Software Updater.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Managing Color - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac
Parent topic: Printing from a Computer
Related tasks
Checking for Software Updates

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

4. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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5. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Note: Paper sizes may include additional options such as Borderless.

6. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

7. Do one of the following:
• macOS 13: Select the Printer Options menu and then select Print Settings.
• macOS 12 and earlier: Select Print Settings or Printer Features from the pop-up menu.
You see a menu like this:

Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

8. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

9. Select the Print Quality setting you want to use.
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10. Select the Borderless checkbox if you want to print a borderless photo. If the option is grayed out,
change the Media Type setting to a paper type that supports borderless printing.

11. Select any of the available print options.
Print Quality Options - Mac
Print Options - Mac
Parent topic: Printing on a Mac
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Print Layout Options - Mac
Selecting Page Setup Settings - Mac
Managing Color - Mac
Printing Your Document or Photo - Mac

Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.
Draft-Vivid

For draft printing on plain paper with good quality and print speed.
Normal

For everyday text and image printing.
Normal - Vivid

For everyday text and image printing with good quality and print speed.
Fine

For text and graphics with good quality and print speed.
Quality

For text and graphics with increased quality and print speed.
Parent topic: Selecting Basic Print Settings - Mac
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Print Options - Mac
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Expansion

If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to
Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.
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2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the Landscape setting.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu or expanding it in the print window and then selecting a scaling option.

Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu or expanding it on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing on a Mac
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Managing Color - Mac
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or
turn off color management in your printer software.

Note: The menus may look different, depending on the Mac OS version and the application you are
using.

1. Do one of the following:
• macOS 13: Select the Printer Options menu and then select Color Matching.
• macOS 12 or earlier: Select Color Matching from the pop-up menu in the print window.
You see a menu like this:

2. Select one of the available options.
3. Do one of the following:

• macOS 13: Select Color Options.
• macOS 12 or earlier: Select Color Options from the pop-up menu in the print window.
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You see a menu like this:

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac
Parent topic: Printing on a Mac

Color Matching and Color Options - Mac
You can select these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer driver or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

Color Options Settings

Note: These options may be located under Color Options in the Printer Options menu.
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EPSON Vivid
Processes colors to create standard hues. Click the Advanced Color Settings tab to use advanced
color controls.

Manual Settings
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences or System Settings.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.
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You see a screen like this:

Note: The available settings and appearance of the options window may be different than those
covered here, depending on the Mac OS version and the application you are using.

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing on a Mac

Printing Preferences - Mac
You can select these settings on the Options or Driver tab.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing but may decrease print speed.
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Bidirectional printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print
quality.

Remove white borders
Removes white margins that may appear when you print borderless photos.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Reduce Print Data Size
Increases print data compression to improve print speed. Not recommended when printing fine
patterns.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - Mac
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Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac

Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:

2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - Mac

Printing from a Smartphone or Tablet
You can print from a smartphone or tablet running iOS or Android using the Epson Smart Panel app.

Note: Your device must be connected to the same wireless network as your Epson product, and Epson
Smart Panel must be configured for use with your product.
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1. Download the Epson Smart Panel app from your device's app store or from Epson's website.
2. Open the Epson Smart Panel app and select a print menu on the home screen.
3. Follow the on-screen instructions to begin printing.
Parent topic: Printing from a Computer
Related tasks
Using the Epson Smart Panel Mobile App

Printing with Epson Photo+
You can print photos, CD/DVD labels, and more using a variety of layouts and templates with Epson
Photo+. Features include image corrections and adjustments, and adding text and stamps to photos. We
recommend printing on genuine Epson photo paper for the best results. Make sure you have set up your
product as described on the Start Here sheet and installed the Epson Photo+ software. See the Epson
Photo+ help utility for more information.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use
Epson Photo+. You also cannot download and install any Epson product software from the Epson
website for use with Windows 10 S; you must obtain software only from the Windows Store.

Parent topic: Printing from a Computer

Cancelling Printing Using a Product Button
If you need to cancel printing, press the stop button.
Parent topic: Printing from a Computer
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Scanning
You can scan your originals and save them as digital files.
Starting a Scan
Scanning in Epson Scan 2

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.
Starting a Scan Using the Product Control Panel
Starting a Scan Using Epson ScanSmart
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet
Scanning a Document in Epson ScanSmart
Selecting Epson ScanSmart Settings
Parent topic: Scanning
Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's control panel buttons.
Your product automatically selects default scan settings, but you can view or change them as necessary.
If you are scanning to a computer, you can change the default scan settings using the Event Manager
utility on the computer.

Note: Make sure you have installed Epson Scan 2, Epson ScanSmart, and Epson Event Manager on
your computer and connected the product to your computer or network. Restart your computer after
installing the product software to enable scanning from the control panel. Also make sure the Event
Manager program is not being blocked by your firewall or security software.

Scanning to a Connected Computer
Setting Up a WSD Port (Windows 7/Windows Vista)
Scanning Using WSD - Windows
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Changing Default Scan Job Settings
Parent topic: Starting a Scan
Related topics
Placing Originals on the Product
Wi-Fi Networking

Scanning to a Connected Computer
You can scan an original and save it to a connected computer using your product's control panel. The
computer must be connected using a USB cable or connected to the same network as your product.
You can save the scanned file as a JPEG or PDF file. You can also set up custom scan settings using
Event Manager and automatically scan using those settings on your product control panel.

Note: Be sure you have installed Epson ScanSmart, Epson Scan 2, and Epson Event Manager on your
computer before scanning to your computer.

1. Place your original on the product for scanning.
2. Press the home button, if necessary.
3. Press the arrow buttons to select Scan to Computer, then press the OK button.

4. Select one of the following options for saving the scanned image:
• Preview on Computer to preview the scanned image on your computer before saving it

(Windows 7 or later, or OS X 10.11 or later).
• Save as JPEG to save the scanned image as a JPEG file on your computer or as an image

capture on a Mac.
• Save as PDF to save the scanned document or image as a PDF file on your computer or as an

image capture on a Mac.
5. If the Select a computer screen is displayed, select a computer on which to save the scanned

images.
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6. Press the start button to start scanning.
When using Windows 7 or later, or OS X 10.11 or later, Epson ScanSmart opens and your product
scans your original and saves the scanned file to your computer.

Note: Click Help in Epson ScanSmart for detailed information.

Parent topic: Starting a Scan Using the Product Control Panel
Related topics
Wi-Fi Networking
Placing Originals on the Product

Setting Up a WSD Port (Windows 7/Windows Vista)
You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first
set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on
Windows 11, Windows 10 and Windows 8.x).
Before you set up a WSD port, make sure you installed your product software, and connected your
product and computer to the same network.
1. Turn on your product.
2. Print a network status sheet so you can identify the network name and model name for your product

on the network.

3. Click or Start and select Computer.
4. On the left side of the window, select Network.
5. Locate your product on the Network screen, right-click it, and select Install.
6. When you see the User Account Control screen, click Continue.

Note: If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the
message.

8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then
click Close.

9. Do one of the following:

• Windows 7: Click and select Devices and Printers.
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• Windows Vista: Click Start and select Control Panel > Hardware and Sound > Printers.
10. Make sure that an icon appears for your product's name on the network.
When you use WSD, select your product name to scan over the network.
Parent topic: Starting a Scan Using the Product Control Panel
Related tasks
Printing a Network Status Sheet
Related topics
Wi-Fi Networking

Scanning Using WSD - Windows
You can scan originals to a computer from the product control panel using WSD (Web Services for
Devices) for network scanning in Windows.

Note: To use this feature on Windows 7 or Windows Vista, you must first set up WSD on the computer.
See Windows help for instructions.

1. Place your original on the product for scanning.
2. Press the home button, if necessary.
3. Press the arrow buttons to select To WSD, then press the OK button.

4. Select a computer.
5. Press the start button to start scanning.
Parent topic: Starting a Scan Using the Product Control Panel

Changing Default Scan Job Settings
You can view or change the default scan job settings your product uses when you scan to your
computer. You do this using the Event Manager program.
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1. Do one of the following to open Event Manager:

• Windows 11: Click , then search for Event Manager and select it.

• Windows 10: Click and select Epson Software > Event Manager.
• Windows 8.x: Navigate to the Apps screen and select Event Manager.

• Windows (other versions): Click or Start > All Programs or Programs > Epson Software >
Event Manager.

• Mac: Open the Applications folder, click Epson Software, and select Event Manager.
2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if

necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or

change.
5. Change the settings as necessary.

Note: If you create a new job, you can only assign it to the Custom Action setting. You can change
the settings of the other assigned jobs, but you cannot rename them or select a different job.

6. Click OK.
7. Click Close to close the Event Manager window.
Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using Epson ScanSmart
You can start the Epson ScanSmart program to scan originals and easily review and edit scanned
images. After that, you can save, print, or share them.

• Windows 11: Click , then search for Epson ScanSmart and select it.

• Windows 10: Click > Epson Software > Epson ScanSmart.
• Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select Epson
Software > Epson ScanSmart.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson ScanSmart.
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You see a screen like this:

Parent topic: Starting a Scan

Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 11: Click , then search for Epson Scan 2 and select it.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.
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• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan
Related tasks
Scanning in Epson Scan 2

Starting a Scan from a Smartphone or Tablet
You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection.
1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See

the link below.
2. Place your original on the product for scanning.
3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.
Parent topic: Starting a Scan
Related tasks
Using the Epson Smart Panel Mobile App
Related topics
Placing Originals on the Product

Scanning a Document in Epson ScanSmart
You can scan and review documents and photos in Epson ScanSmart.

Note: The images in this guide show Windows screens. Mac screens may be slightly different.
Depending on your product model and software version, not all options may be available.

1. Load your original into the product.
2. Open Epson ScanSmart on your computer. Do one of the following:

• Windows 11: Click , then search for Epson ScanSmart and select it.

• Windows 10: Click > Epson Software > Epson ScanSmart.
• Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Epson ScanSmart.
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• Mac: Open the Applications folder, open the Epson Software folder, and select Epson
ScanSmart.
You see a screen like this:

3. Select an option for the Scan area setting, if necessary.

Note: The Scan area setting limits the scan area to a selected size starting at the placement arrow
on the scanner bed. It does not scale the image to the selected size.

4. Select SCAN.
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The original is scanned. When scanning is complete, you see a screen like this:

5. You can review, edit, or reorder the scanned images as follows:
• Select + Scan to scan more originals.
• Select Delete to delete selected scanned images.
• Select Rotate Right to rotate each scanned image.
• Select Crop to crop the selected image.
• Control-click two images, select Stitch Images, and follow the on-screen instructions to combine

them into a single image.
6. If Photo Mode is automatically detected, the following enhancement options are available:

• Auto Color Enhancement: automatically adjusts the brightness, contrast, and saturation of your
photos

• Restore Faded Colors: restores the colors in faded photos automatically
• Remove Red Eye: automatically removes the red-eye effect from your photos
• Auto Cropping: automatically crops the scanned image edges

7. When you finish reviewing and editing the scanned images, click Next.
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You see a screen like this:

8. Select an option to save, send, or print the scanned images. See the links below.
Saving a Scan
Attaching a Scan to Email
Sending a Scan to a Cloud Service
Printing a Scan
Parent topic: Starting a Scan
Related topics
Placing Originals on the Product

Saving a Scan
You can save a scanned image to your computer in a variety of formats.
1. Make sure your originals are scanned and reviewed. See the link at the end of this section.
2. In the Select Action window, click Save.
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You see a screen like this:

3. Change the settings as follows:
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• Select the folder on your computer in which to save the file.

4. Click Save.
Parent topic: Scanning a Document in Epson ScanSmart

Attaching a Scan to Email
You can attach a scanned image to an email as a file attachment.

Note: Your email app and account settings should be configured before scanning. You must install a
MAPI-type email program such as Outlook Express, Entourage, or Mac Mail. Attach to Email only
supports 32-bit MAPI-compatible mail apps. Web-based email services such as Gmail are not
supported. If you see an error message, your email app may not be compatible and you will need to save
the scans and manually attach the file to an email.

1. Make sure your originals are scanned and reviewed. See the link at the end of this section.
2. In the Select Action window, click Attach to Email.
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You see a screen like this:

3. Change the settings as follows:
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• If you also want to save a copy of the scanned image to your computer, make sure the checkbox

is selected and select the folder on your computer in which to save the file.
4. Click Attach to E-mail.

Your email program opens with the file attached to a new email.
Parent topic: Scanning a Document in Epson ScanSmart

Sending a Scan to a Cloud Service
You can upload scanned images to a cloud service.
1. Make sure your originals are scanned and reviewed. See the link at the end of this section.
2. In the Select Action window, click one of the cloud service send options.
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You see a screen like this:

3. Log in to your account.

Note: You may need to allow Epson ScanSmart access to your account. The first time you log in,
you may be prompted to enter an authentication code.

4. Change the settings as follows:
• Select the folder in your account where you want to send the document. (Documents can be

saved to top-level folders only.)
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• If you also want to save a copy of the scanned image to your computer, click the checkbox.

5. Click Send.
Parent topic: Scanning a Document in Epson ScanSmart

Printing a Scan
You can print your scanned image and save the scanned file to your computer.
1. Make sure your originals are scanned and reviewed. See the link at the end of this section.
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2. In the Select Action window, click Print.
You see a screen like this:

3. Change the settings as follows:
• Select the Epson printer and change the print settings, if necessary.
• Select the number of copies you want to print.
• If you also want to save a copy of the scanned image to your computer, click the checkbox.
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• Select the folder on your computer in which to save the file.

4. Click Print.
Parent topic: Scanning a Document in Epson ScanSmart

Selecting Epson ScanSmart Settings
After starting Epson ScanSmart, you can change various scanning settings.
Changing the Epson Product
Changing the Scan Settings
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Changing the File Name Settings
Changing the Save Settings
Save Settings
Customizing Action Icons
Parent topic: Starting a Scan

Changing the Epson Product
If you are using more than one Epson product with Epson ScanSmart, you can change the product that
you are using with your computer.

Note: A product connected to your computer via USB takes priority over a product with a Wi-Fi
connection.

1. On the main screen, click Change.
You see a screen like this:

2. Select the Epson product you want to use with your computer and click OK.
Parent topic: Selecting Epson ScanSmart Settings
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Changing the Scan Settings
You can change detailed scan settings such as the resolution, document size, and more.

Note: If you select Auto Mode, you cannot change the scan settings.

1. Click the Settings button.
You see a screen like this:

2. Do one of the following:
• To change Document Mode settings, select Document Mode > Custom Settings.
• To change Photo Mode settings, select Photo Mode and click Close. When you start a scan, you

will be prompted to select scan settings.
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You see a screen like this:

3. Change the settings as necessary and click Save.
Parent topic: Selecting Epson ScanSmart Settings

Changing the File Name Settings
You can change the default file naming method for your scans.
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1. Click the Settings button.
You see a screen like this:

2. Click the File Name Settings tab.
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You see a screen like this:

3. Change the settings as necessary:
• Enter a prefix for the file name.
• Select the date format.
• Select a numbering format as the counter format.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Changing the Save Settings
You can change the file type options for saving your scans.

1. Click the Settings button.
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You see a screen like this:

2. Click the Save Settings tab.



132

You see a screen like this:

3. Click Options for a file format and change the settings as necessary.
4. Click Open folder after saving to open the file folder after a file is saved.
5. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Save Settings
You can change the settings for how scanned images are saved.
PDF Options

Setting Options Description
General Generate PDF/A File Creates a PDF that conforms to

PDF/A-1 standards
Create file with all pages Saves all pages as one file
Compression Level Selects the compression level for color

or grayscale images



133

JPEG Options

Setting Options Description
Image Quality Options — Sets a compression level by moving a

slider or entering a value. File size
increases the higher the resolution is.

Encoding (Windows only) Standard Images load from top to bottom in a
web browser. It takes longer to load the
entire image.

Progressive Images first load completely at low
resolution and then adjust to high
resolution in a web browser

Embed ICC Profile (Windows
only)

— Allows you to add ICC profiles to the
image

TIFF Options

Setting Options Description
Byte Order Windows

Macintosh
Specifies the operating system where
the scanned image will be used

Compression (Windows only) — Specifies the compression format and
level for Color/Grayscale and B&W
images. File size increases with higher
quality.

Embed ICC Profile (Windows
only)

— Allows you to add ICC profiles to the
image

Parent topic: Selecting Epson ScanSmart Settings
Customizing Action Icons

You can customize which scan action icons appear on the Select Action screen.

Note: You can also customize them by clicking the Customize icon on the Select Action screen.

1. Click the Settings button.
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You see a screen like this:

2. Click the Customize Actions tab.
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You see a screen like this:

3. Choose which action icons to display by selecting or deselecting each checkbox. Click the arrow
icons to move the icons up or down in the display order you want.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Scanning in Epson Scan 2
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Start Epson Scan 2.
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You see this window:
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2. Select the Mode setting that matches the type of original you are scanning.
3. Select the Document Source setting that matches where you placed your original.
4. Select the Document Size setting that matches the size of your original. You can select Customize

to enter a custom size, if necessary.
5. Select the image type of your original and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Select the Rotate setting to rotate the scanned image.
8. Select the Correct Document Skew setting to correct skewed originals, image contents, or both.
9. Click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

10. Select any of the additional settings that you want to use on the Main Settings tab.
11. Click the Advanced Settings tab and select any settings that you want to use.
12. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
13. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to

modify the file name settings.
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14. Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to create a new folder.

15. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Image Format Options
Scan Resolution Guidelines
Parent topic: Scanning

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Rotate

Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Remove Background

Removes the background of the originals.
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Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Corrects color in faded images (when scanning in Photo Mode).

Backlight Correction
Lightens darkly backlit images (when scanning in Photo Mode).

Dust Removal
Removes dust on scanned images (when scanning in Photo Mode).

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2
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Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software as instructed on the Start Here sheet. If you install your scanner software programs
individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. Select Searchable PDF as the Image Format setting.
6. Select Options from the Image Format list.

You see this window:
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7. Select any of the options on the General tab.
8. Select the Text tab.
9. Make sure the language used in the document text is selected as the Text Language setting.
10. Click OK.
11. Confirm the File Name setting and select a Folder setting for your document.
12. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning in Epson Scan 2

Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
BITMAP (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.
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Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your
scans. Increasing the resolution raises the amount of detail captured but comes with the following
disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same
amount you will increase the image size to retain a high image quality. For example, if the resolution is
300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600
dpi.

• You will scan the image at 100% or a smaller size.
Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2
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Refilling Ink and Replacing the Maintenance Box
When the ink level is below the lower line on an ink tank, you need to refill it. Periodically check the ink
tanks to see if they need to be refilled.
Before checking the ink levels or refilling an ink tank as described here, be sure to read the ink safety
precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Ink Safety Precautions
Checking the Ink and Maintenance Box Levels
Purchase Epson Ink and Maintenance Box
Refilling the Ink Tanks
Maintenance Box Replacement

Ink Safety Precautions
Note: Epson strongly recommends the use of genuine ink to ensure optimal print quality and
performance.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it
estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may
generate inaccurate messages if the ink tanks are not refilled according to these instructions.
Visually check the ink levels in the product’s ink tanks to confirm the actual ink levels. Continued use of
the product when the ink is expended could damage the product.

Ink Handling Precautions
• Keep ink bottles and the ink tanks out of the reach of children. Do not allow children to drink from or

handle the ink bottles and bottle caps.
• Do not tilt or shake an ink bottle after opening it; otherwise, ink may leak.
• Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink bottles or

ink bottle caps.
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• If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them
immediately with water. If discomfort or vision problems persist, see a doctor immediately. If ink gets
into your mouth, spit it out and see a doctor right away.

• Do not disassemble the maintenance box; otherwise ink may get into your eyes or on your skin.
• Do not squeeze the ink bottles.
• Do not shake an ink bottle too vigorously or subject it to strong impacts; otherwise, ink may leak.
• If ink spills, wipe it up immediately. To prevent the ink from spreading, blot the spill with a dry cloth,

then wipe it with a damp cloth. The ink will be hard to remove once it has dried.

Ink Refilling Precautions
• Use ink bottles with the correct part number for this product.
• The use of non-Epson ink may cause damage that is not covered by Epson’s warranty, and under

certain circumstances, may cause erratic product behavior.
• Do not open the ink bottle package until you are ready to fill an ink tank. Ink bottles are vacuum

packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print
quality may be affected.

• If the ink level is below the lower line on an ink tank, refill the ink. Continued use of the product when
the ink level is below the lower line on an ink tank could damage the product.

• Visually check the ink levels in the product’s ink tanks to confirm the actual ink levels. Continued use
of the product when the ink is expended could damage the product.

• Do not maintain low ink levels for extended periods of time.
• Epson recommends filling all ink tanks to the upper line when the product is not operating to reset the

ink levels.
• Be sure to reset the ink level after refilling the ink. If you refilled two or more colors, you need to select

all of the colors that you refilled and reset the ink level. Unless you reset the ink level, the ink level
displayed does not change even after refilling the ink.

• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for
at least three hours before using it.

• Epson recommends using the ink bottle before the date printed on the package.
• After opening an ink bottle, Epson recommends using it as soon as possible.
• Wipe off any ink around the tanks and ports with a clean, lint-free cloth or cotton swab.
• Store ink bottles in a cool, dark place. Keep them out of direct sunlight.
• Do not store the ink bottles in high or freezing temperatures.
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• Store the ink bottles in the same environment as the product. When storing or transporting an opened
ink bottle, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink
may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright
when tightening the cap, and take measures to prevent ink from leaking when you transport the bottle.

• Handle ink carefully. Ink may splatter when the ink tanks are being filled or refilled with ink. If ink gets
on your clothes or belongings, it may not come off. If ink adheres to the area around the tank, wipe it
off using a lint-free, clean cloth or cotton swab.

Ink Bottle and Ink Tank Information
• To maintain optimum print head performance, some ink is consumed from all ink tanks during printing

and when performing maintenance operations, such as cleaning the print head. Ink may also be
consumed when the product is turned on.

• Some ink in the ink bottles supplied with your product is used during initial setup; these ink bottles will
print fewer pages compared to subsequent ink bottles.

• Quoted ink yields may vary depending on the images you are printing, the paper type you are using,
how often you print, and environmental conditions such as temperature.

• The ink bottles may contain recycled materials, but this does not affect product function or
performance.

• When printing in monochrome or grayscale, color ink may be used instead of black ink, depending on
the paper type or print quality settings. This is because a mixture of color inks is used to create black.

• A reserve amount of ink remains in the tank when your product indicates that a refill is necessary. The
yields quoted for you do not include this reserve.

Parent topic: Refilling Ink and Replacing the Maintenance Box

Checking the Ink and Maintenance Box Levels
Your product and software will let you know when to refill an ink tank or replace the maintenance box.
Checking Ink Levels on Your Product
Checking Ink and Maintenance Box Levels - Windows
Checking Ink and Maintenance Box Levels - Mac
Disabling Special Offers with Windows
Parent topic: Refilling Ink and Replacing the Maintenance Box
Related concepts
Maintenance Box Replacement
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Related references
Ink Safety Precautions
Related tasks
Refilling the Ink Tanks

Checking Ink Levels on Your Product
To confirm the actual ink levels, visually check the ink levels in the product’s ink tanks. Make sure the ink
levels are above the lower lines on the ink tanks.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it
estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may
generate inaccurate messages if the ink tanks are not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below
the lower line. Continued use of the product when the ink level is below the lower line on the tank could
damage the product.

Note: You can also check the approximate ink levels from the status monitor on the printer driver.

Parent topic: Checking the Ink and Maintenance Box Levels
Related tasks
Refilling the Ink Tanks

Checking Ink and Maintenance Box Levels - Windows
A low ink reminder appears if you try to print when ink is low, and you can check your ink levels at any
time using a utility on your Windows computer.
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1. To check your ink and maintenance box levels, access the Windows Desktop and double-click the
icon for your product in the right side of the Windows taskbar, or click the up arrow and double-

click .
You see a window like this:

2. Refill any ink tank or replace the maintenance box as needed.



148

Note: The ink levels displayed are an estimate and may differ from the actual ink remaining in the ink
tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks. Continued
use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Checking the Ink and Maintenance Box Levels
Related tasks
Refilling the Ink Tanks
Replacing the Maintenance Box

Checking Ink and Maintenance Box Levels - Mac
You can check your ink levels using a utility on your Mac.
1. In the Apple menu or the Dock, select System Preferences or System Settings. Select Print &

Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.

2. Select EPSON Status Monitor.
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You see a window like this:

3. Refill any ink tank or replace the maintenance box as needed.

Note: To update or refresh the displayed ink levels, click Update.

Note: The ink levels displayed are an estimate and may differ from the actual ink remaining in the ink
tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks. Continued
use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Checking the Ink and Maintenance Box Levels
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Related tasks
Refilling the Ink Tanks
Replacing the Maintenance Box

Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

Note: You may see the Epson Special Offers screen every time you print (if your computer is connected
to the Internet). Select Do not display this message again and click Decline to disable online offers.
Promotional offers are not valid in Latin America.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Monitoring Preferences.
You see a window like this:
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2. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Checking the Ink and Maintenance Box Levels

Purchase Epson Ink and Maintenance Box
You can purchase genuine Epson ink, maintenance boxes, and paper from an Epson authorized
reseller. To find the nearest reseller, visit latin.epson.com or call your nearest Epson sales office.

Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottles that are used for initial product setup have a lower yield due to the ink charging process.
This process is carried out the first time you turn on the printer and guarantees better performance.
Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and
temperature. Do not load paper before refilling the ink tanks.
Check the ink levels in your product frequently, and refill the ink tanks if necessary.

Ink Bottle and Maintenance Box Part Numbers
Parent topic: Refilling Ink and Replacing the Maintenance Box

Ink Bottle and Maintenance Box Part Numbers
Use these part numbers when you order or purchase a new maintenance box or ink bottles.
Maintenance box part number: C9344

Note: Once a maintenance box has been installed in a product it cannot be used with other products.

Ink color Part number
Single pack
Black T544120-AL
Cyan T544220-AL
Magenta T544320-AL
Yellow T544420-AL
Multipack*

Black (×2) T544120-2P

https://latin.epson.com
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Ink color Part number
Cyan, magenta, and yellow (×1 each) T544520-3P
Black, cyan, magenta, and yellow (×1 each) T544520-4P

* Availability of ink bottle multipacks varies by region.
Parent topic: Purchase Epson Ink and Maintenance Box

Refilling the Ink Tanks
Make sure you have new ink bottles handy and have read the ink safety precautions before you begin.
You can continue to use the product even if one or more ink tanks are not filled all the way. However, for
the most accurate ink level monitoring, fill all the ink tanks up to the top line and reset the ink level
immediately.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it
estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may
generate inaccurate messages if the ink tanks are not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below
the lower line. Continued use of the product when the ink level is below the lower line on the tank could
damage the product.

Caution: Wear disposable gloves while refilling the ink tanks to avoid staining your hands. If ink spills,
wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your clothes or
belongings, it may not come off.

1. Turn on your product.
2. Press the arrow buttons to select Maintenance, then press the OK button.

3. Select Fill Ink and press the OK button.
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4. Press the down arrow button to read all the safety and usage precautions for filling ink, and then
press the OK button to continue.

5. Open the ink tank cover.

6. Open the cap for the ink tank you are going to fill.

Note: Make sure the color of the ink tank matches the ink color you want to refill. Refer to the color-
coded sticker on the ink tank unit to identify the color of each tank. Do not force the bottles into
position; they are keyed for each color.
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7. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after its cap is
removed. Do not allow the top of the ink bottle to hit any objects after removing its cap; otherwise, ink
may spill.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If discomfort or problems persist, see a doctor immediately. If ink
gets into your mouth, spit it out and see a doctor right away. Keep the ink bottles out of the reach of
children and do not drink the ink.

8. Check the upper line in the ink tank.
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9. Insert the bottle into the ink filling port and wait for the ink to fill the tank. Do not squeeze the bottle.
Ink flows into the tank and stops automatically when the ink is filled to the upper line.

Note: If ink does not flow from the bottle, lift and reinsert the bottle. If the ink has reached the upper
line of the tank, do not remove and reinsert the bottle or ink may leak.

10. When the ink tank is full, remove the ink bottle and securely close the ink tank cap.
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Note: Do not leave the ink bottle inserted. The bottle may be damaged or ink may leak. If any ink
remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for later use.

11. Repeat the previous steps as necessary for each ink tank you need to refill.
12. Close the ink tank cover firmly.

13. Press the start button.
14. Follow the on-screen instructions to reset the ink level for the colors you refilled.

Note: Make sure to reset the ink levels immediately after refilling the ink. You need to reset the ink
level for each of the colors you refilled; otherwise the ink level displayed will not change even after
the ink is refilled.

Even if you do not refill ink up to the upper line on the ink tank, you can continue using the product. To
keep your product operating at its best, however, fill ink tank up to the upper line and reset the ink level
immediately.
Parent topic: Refilling Ink and Replacing the Maintenance Box
Related concepts
Purchase Epson Ink and Maintenance Box
Related references
Ink Safety Precautions
Related tasks
Checking Ink Levels on Your Product
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Maintenance Box Replacement
The maintenance box stores surplus ink that gets collected during printing or print head cleaning. To
prevent ink leakage from the maintenance box, the printer is designed to stop printing when the
absorbing capacity of the maintenance box has reached its limit. Whether and how often this is required
will vary according to the number of pages you print, the type of material that you print on, and the
number of cleaning cycles that the printer performs. When you see a message on the LCD screen, follow
the on-screen instructions to replace the maintenance box.
Note the following precautions when replacing the maintenance box:
• Do not remove the maintenance box or its cover except when replacing the maintenance box;

otherwise, ink may leak.
• Do not touch the areas of the maintenance box or inside the product as shown below.

• Do not tilt the maintenance box after removing it; otherwise, ink may leak.
• Do not touch the openings in the maintenance box or you may get ink on you.
• Do not drop the maintenance box or subject it to strong shocks and do not store it in high or freezing

temperatures.
• If you cannot close the maintenance box cover, make sure the maintenance box is installed properly.
• Keep the maintenance box out of direct sunlight.
• Do not replace the maintenance box during printing; otherwise, ink may leak.
• Do not disassemble the maintenance box; otherwise ink may get into your eyes or on your skin.
• Do not reuse a maintenance box that has been removed and left uninstalled for a long period of time.
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• If you cannot re-attach the cover, the maintenance box may not be installed correctly. Remove and re-
install the maintenance box.

Note: The maintenance box is a user-replaceable part and is not covered by the product warranty.

Replacing the Maintenance Box
Parent topic: Refilling Ink and Replacing the Maintenance Box
Related references
Ink Safety Precautions

Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week.

Note: You cannot print or clean the print head while the maintenance box is full, but you can perform
tasks that do not require ink, such as scanning.

Note: If you see a message about the borderless ink pad on the LCD screen, contact Epson for support.
The borderless ink pad is not a user-replaceable part.

1. Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box. Doing so may prevent normal
operation and printing.
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3. Use a flat-head screwdriver to loosen the screw on the maintenance box cover as shown, then
remove the cover.

4. Grasp the maintenance box as shown and pull it out of its holder.

Note: Do not tilt the used maintenance box until after it is sealed in the plastic bag; otherwise ink
may leak.



160

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep the maintenance box out of the reach of children and do not drink the ink.

5. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

6. Insert the new maintenance box into the holder and push it all the way in until it clicks into place.

Note: Make sure you insert the maintenance box in the correct direction.
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7. Insert the maintenance box cover and tighten the screw to secure the cover.

If you cannot re-attach the cover, the maintenance box may not be installed correctly. Remove and
re-install the maintenance box.

8. Check the message on the LCD screen, then press the OK button to confirm.

Note: Once a maintenance box has been installed in a product it cannot be used with other
products.

Parent topic: Maintenance Box Replacement
Related references
Ink Safety Precautions
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the
paper path.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide
Checking the Number of Sheets Fed

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in any of the tanks is low. You must refill the ink tank first.

If you still see white or dark lines or gaps in your printouts after repeating nozzle check and head
cleaning 3 times, wait for at least 12 hours without printing, and then run the nozzle check again and
repeat the head cleaning if necessary. If print quality has still not improved, you can run a Power
Cleaning.
Print Head Nozzle Check
Print Head Cleaning
Power Cleaning
Parent topic: Adjusting Print Quality
Related concepts
Purchase Epson Ink and Maintenance Box
Maintenance Box Replacement
Related tasks
Refilling the Ink Tanks
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Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Press the arrow buttons to select Maintenance, then press the OK button.

5. Press the OK button again to select Nozzle Check.
6. Follow the on-screen instructions to load paper and print the nozzle check pattern, then press the

start button to print.
The nozzle check pattern is printed.



164

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

8. Do one of the following:
• If there are no gaps, the print head is clean. Select No and press the OK button.
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• If there are gaps or the pattern is faint, select Yes and press the OK button. Follow the instructions
on the screen to clean the print head. When cleaning is finished, the nozzle check pattern is
printed automatically.

• If all or most of the lines are missing, select No to exit the nozzle check menu and run a Power
Cleaning instead.

9. Repeat the above steps until all lines are printed completely.

Important: Do not open the inner cover or turn off the printer during head cleaning. If the head
cleaning is incomplete, you may not be able to print.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then run another nozzle check and try cleaning the print head again. If print quality still
does not improve, run a Power Cleaning.
Parent topic: Print Head Nozzle Check
Related tasks
Cleaning the Print Head Using the Product Control Panel
Power Cleaning Using the Product Control Panel
Related topics
Loading Paper

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in the product.
2. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences or System Settings. Select
Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

3. Select Nozzle Check or Print Head Nozzle Check.
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You see a window like this:

4. Click Print.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

6. Do one of the following:
• If there are no gaps, click Finish.
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• If there are gaps or the pattern is faint, clean the print head.
• If almost the entire pattern is missing, click Finish and perform a Power Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn the product off using
the power button and wait at least 12 hours. Then run a nozzle check and try cleaning the print head
again, if necessary. If quality still does not improve, run a Power Cleaning.
Parent topic: Print Head Nozzle Check
Related tasks
Cleaning the Print Head Using a Computer Utility
Power Cleaning Using a Computer Utility
Related topics
Loading Paper

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may
have to refill the ink tank first.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in any of the tanks is low. You must refill the ink tank first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related concepts
Purchase Epson Ink and Maintenance Box
Maintenance Box Replacement
Related tasks
Refilling the Ink Tanks

Cleaning the Print Head Using the Product Control Panel
You can clean the print head nozzles using the control panel on your product.
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Note: Head cleaning consumes ink and should not be performed more than necessary.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Press the arrow buttons to select Maintenance, then press the OK button.

5. Select Head Cleaning and press the OK button.
6. Press the start button to clean the print head.

Caution: Never open the inner cover or turn off the product during a cleaning cycle or you may
damage it.

You see a message on the LCD screen and the power light flashes throughout the cleaning cycle.
When the cleaning cycle is finished, the power light stays on and you see a message on the LCD
screen.

7. Select Nozzle Check, press the OK button, and press the start button to run a nozzle check and
confirm that the print head is clean.
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8. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

9. Do one of the following:
• If there are no gaps, the print head is clean. Select No and press the OK button.
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• If there are gaps or the pattern is faint, select Yes and press the OK button. Follow the instructions
on the screen to clean the print head.

• If all or most of the lines are missing, select No and run a Power Cleaning instead.
If you don’t see any improvement after cleaning the print head up to 3 times, turn the product off using
the power button and wait at least 12 hours. Then run a nozzle check and try cleaning the print head
again, if necessary. If quality still does not improve, run a Power Cleaning. If there is still no
improvement, contact Epson support.
Parent topic: Print Head Cleaning
Related references
Where to Get Help (Latin America)
Related tasks
Checking the Nozzles Using the Product Control Panel
Power Cleaning Using the Product Control Panel
Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences or System Settings. Select
Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

4. Select Head Cleaning or Print Head Cleaning.
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You see a window like this:

5. Click Start to begin the cleaning cycle.
You see a message on the computer screen during the cleaning cycle. The power light flashes
throughout the cleaning cycle and stays on when the cleaning cycle is finished.

Caution: Never open the inner cover or turn off the product during a cleaning cycle or you may
damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.
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• If almost the entire pattern is missing, click Finish and perform a Power Cleaning.
If you don’t see any improvement after cleaning the print head up to 3 times, turn the product off using
the power button and wait at least 12 hours. Then run a nozzle check and try cleaning the print head
again, if necessary. If quality still does not improve, run a Power Cleaning.
Parent topic: Print Head Cleaning
Related references
Where to Get Help (Latin America)
Related tasks
Checking the Nozzles Using a Computer Utility
Power Cleaning Using a Computer Utility
Related topics
Loading Paper

Power Cleaning
If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head
several times, you can run a Power Cleaning.
If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12
hours without printing, then print the nozzle check pattern again. Run Head Cleaning or Power Cleaning
again depending on the printed pattern. If quality still does not improve, contact Epson support.

Caution: Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make
sure each ink tank is at least one-third full before running a Power Cleaning, or it may damage the
product.

Caution: Power Cleaning may cause the maintenance box to reach its capacity sooner. When the
maintenance box is full, you need to replace it to continue printing. If the ink levels or the free space in
the maintenance box are insufficient for Power Cleaning, you cannot run this feature.

Power Cleaning Using the Product Control Panel
Power Cleaning Using a Computer Utility
Parent topic: Print Head Maintenance
Related tasks
Refilling the Ink Tanks
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Power Cleaning Using the Product Control Panel
You can run a Power Cleaning using the control panel on your product.

Note: After a Power Cleaning, you must wait at least 12 hours before running another Power Cleaning.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Visually check the ink levels and make sure each ink tank is at least one-third full.

Caution: If you run a Power Cleaning when the ink levels are low, or there is not enough free space
in the maintenance box, you may damage the product.

3. Load a few sheets of plain paper in the product.
4. Press the home button, if necessary.
5. Press the arrow buttons to select Maintenance, then press the OK button.

6. Select Power Cleaning and press the OK button.
7. Follow the instructions on the LCD screen to run the Power Cleaning.
8. When the Power Cleaning is finished, run a nozzle check.
If print quality did not improve after running Power Cleaning, wait at least 12 hours without printing, then
print the nozzle check pattern again. Run Head Cleaning or Power Cleaning again depending on the
printed pattern. If quality still does not improve, contact Epson support.
If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.
Parent topic: Power Cleaning
Related references
Where to Get Help (Latin America)
Related tasks
Checking the Nozzles Using the Product Control Panel
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Cleaning the Print Head Using the Product Control Panel
Related topics
Loading Paper

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: Ink will be deposited to the maintenance box. If it becomes full, you must install a new
maintenance box to continue printing.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
running another Power Cleaning.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and
click the Maintenance tab.

• Mac: In the Apple menu or the Dock, select System Preferences or System Settings. Select
Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

4. Select Power Cleaning.
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You see a window like this:

5. Follow the on-screen instructions to run a Power Cleaning.
6. When Power Cleaning is finished, run a nozzle check.
If print quality has not improved after running Power Cleaning, wait for at least 12 hours without printing,
and then print the nozzle check pattern again. Run Print Head Cleaning or Power Cleaning again
depending on the printed pattern. If quality still does not improve, contact Epson support.
Parent topic: Power Cleaning
Related references
Where to Get Help (Latin America)
Related tasks
Checking the Nozzles Using a Computer Utility
Cleaning the Print Head Using a Computer Utility
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Related topics
Loading Paper

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Parent topic: Adjusting Print Quality
Related concepts
Print Head Cleaning
Related topics
Loading Paper

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Press the arrow buttons to select Maintenance, then press the OK button.

5. Select Print Head Alignment and press the OK button.
6. Do one of the following:

• If your printout contains misaligned vertical lines or is blurry, select Vertical Alignment and press
the OK button.
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• If your printout contains horizontal banding, select Horizontal Alignment and press the OK
button.

7. Press the start button to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and use the arrow and OK buttons to select the number representing the
most solid printed pattern for each set on the LCD screen.
Vertical Alignment

Horizontal Alignment

9. Press the OK button when you are finished.
Parent topic: Print Head Alignment
Related topics
Loading Paper

Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.

Caution: Do not use tissues to clean the inside of the product. You can damage the product.
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1. If printouts are smeared or scuffed, load plain paper in this size: Letter (8.5 × 11 inches
[216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

2. Press the arrow buttons to select Maintenance, then press the OK button.

3. Select Paper Guide Cleaning and press the OK button.
4. Follow the on-screen instructions to clean the paper guide.
5. Repeat these steps as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related concepts
Print Head Cleaning
Print Head Alignment
Related topics
Loading Paper

Checking the Number of Sheets Fed
You can view an option that displays the number of sheets of paper that have fed through the product.

Note: You can also view the number of sheets of paper fed through the product by printing a nozzle
check.

Checking the Number of Sheets on the LCD Screen
Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac
Parent topic: Adjusting Print Quality

Checking the Number of Sheets on the LCD Screen
You can view the total number of prints, black-and-white prints, and color prints that have been printed.
1. Select the home icon, if necessary.
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2. Press the arrow buttons to select Settings, then press the OK button.

3. Select Print Counter to view the number of prints.

Note: You can also view the number of prints by printing a nozzle check. Select Maintenance >
Nozzle Check, then follow the on-screen instructions to load paper and print the nozzle check
pattern.

4. If you want to print the result, select Print Sheet.
Parent topic: Checking the Number of Sheets Fed

Checking the Sheet Counter - Windows
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.
4. Select Printer and Option Information.
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You see this window:

5. After checking the number of sheets fed into the printer, click OK to close the window.

Note: The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

Parent topic: Checking the Number of Sheets Fed

Checking the Sheet Counter - Mac
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.
1. In the Apple menu or the Dock, select System Preferences or System Settings. Select Print &

Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.

2. Select Printer and Option Information.
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You see this window:

3. After checking the number of sheets fed into the printer, click OK to close the window.
Parent topic: Checking the Number of Sheets Fed
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cord.

Note: Make sure to unplug the power cord when the power light is off. Otherwise, the print head
does not return to the home position and you may not be able to print.

3. Disconnect any connected cables.
4. Remove all the paper.
5. Open the document cover.



185

Caution: Be careful not to trap your hands or fingers when opening or closing the document cover.

6. Clean the scanner glass with a soft, dry, lint-free cloth (microfiber is recommended). If the glass
surface is stained with grease or some other hard-to-remove material, use a small amount of glass
cleaner and a soft cloth to remove it. Wipe off any remaining liquid.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force. Scratches or other damage on the glass surface can decrease the scan quality.

7. Close the document cover.

8. Clean the outer case and control panel with a soft, clean cloth moistened with a little water. If you
cannot remove the dirt, try cleaning with a soft cloth moistened with a mild detergent.
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Note: Be careful not to get water inside the product or on any electrical components. Otherwise, the
product could be damaged.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it some distance, prepare it for transportation as described
here.
Caution: During transportation and storage, follow these guidelines:
• Place the product in a plastic bag and fold the bag closed.
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not
subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle
is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take
measures to prevent ink from leaking when transporting the ink bottles.
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• Do not put opened ink bottles in the box with the product.

• Before transporting the product, make sure that the print head is in the home (far right) position.
1. Turn off the product.
2. Remove all the paper and any originals from the product.
3. Make sure the power light turns off, then unplug the power cable.
4. Disconnect any connected cables.
5. Open the ink tank cover and make sure that the ink tank caps are securely closed.

6. Close the ink tank cover securely.
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7. Close the paper support and output tray, then lower the control panel by gently pushing it down.

8. Place the product in a plastic bag and fold the bag closed.
9. Place the product in its original packaging materials, if possible, or use equivalent cushioning around

the product.
If print quality has declined when you print again, clean and align the print head.
Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Status Messages
Message Appears Prompting You to Reset Ink Levels
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Product Software
Where to Get Help (Latin America)

Checking for Software Updates
It's a good idea to check Epson's support website occasionally for free updates to your product software.
Visit latin.epson.com/support and select your product.
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:

• Accessing the Windows Desktop and right-clicking the icon for your product in the right side of
the Windows taskbar, or clicking the up arrow and right-clicking .

• On the Maintenance tab in the printer settings window
You can also update the software by selecting EPSON Software Updater in the EPSON or Epson
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

https://latin.epson.com/support
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• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

• macOS 10.12.x to 14.x: You can manually update the software by opening the App Store, selecting
Updates, searching for a software update option for Epson Software, and selecting Update.

Parent topic: Solving Problems

Product Status Messages
You can often diagnose problems with your product by checking the messages on its LCD screen.

Note: If the LCD screen is dark, press any button on the control panel to wake the product from sleep
mode.

Error
code/message

Condition/solution

(E-01) A printer error has occurred. Turn the product off and then back on again. If the error
continues, check inside the product for a paper jam. If there is no paper jam, contact
Epson for support.

(E-02) A scanner error has occurred. Turn the product off and then back on again.
(E-12) A borderless printing ink pad needs to be replaced. Contact Epson for support; this is

not a user-replaceable part. Borderless printing is not available, but printing with a
border is available.

(W-01) A paper jam has occurred. Remove the jammed paper, then press the button
indicated on the LCD screen to clear the error. If the error continues, turn the product
off and back on again.

(W-14) A borderless printing ink pad is nearing the end of its service life. Contact Epson for
support; this is not a user-replaceable part. The error will be displayed until the ink
pad is replaced. (To continue printing, press the start button.)

(I-22) Set Wi-Fi using Push Button (WPS). To establish a wireless connection using a
router or access point, press the button on the router or access point, or click the
button on its wireless settings screen displayed on your computer.

(I-23) Set Wi-Fi using PIN Code (WPS). Enter the PIN code displayed on the LCD screen
into the router, access point, or computer within two minutes. If you wait longer than
two minutes, a time-out error occurs, the code changes, and you must enter a new
code.



191

Error
code/message

Condition/solution

(I-31) Set Wi-Fi using Wi-Fi Auto Connect. To make wireless connection settings from
your computer, run the installer and follow the on-screen instructions.

(I-41) The Paper Setup Auto Display option is disabled. You must enable Paper Setup
Auto Display to use AirPrint.

(I-60) Your computer may not support WSD (Web Services for Devices). The scan to
computer (WSD) function is available only for computers running English versions of
Windows 11, Windows 10, Windows 8.x, Windows 7, or Windows Vista. Make sure
your product is connected correctly to the computer.

Turn the power
off and on
again. If the
problem
persists, contact
XX.

Try the following solutions:
• Turn the printer off and on again.
• If you are using a Wi-Fi connection, turn the wireless router off and on again. If the

error message is still displayed, make a note of the error code, and contact Epson
support.

Recovery Mode A firmware update has failed. Connect your product using a USB cable and try
updating the firmware again. If you still receive this error message, contact Epson for
support.

Note: In some print cycles a very small amount of surplus ink may be collected in the borderless printing
ink pad. To prevent ink leakage from the pad, the product is designed to stop borderless printing when
the pad has reached its limit. Whether and how often this is required will vary according to the number of
pages you print using the borderless print option. The need for replacement of the pad does not mean
that your printer has ceased to operate in accordance with its specifications. The printer will advise you
when the pad requires replacing and this can only be performed by an authorized Epson Service
provider. If this happens during the standard warranty of the product, the replacement of borderless
printing ink pads is covered under the standard warranty.

Parent topic: Solving Problems
Related references
Paper Source Settings Options
Where to Get Help (Latin America)
Related tasks
Checking for Software Updates
Accessing the Web Config Utility
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Using AirPrint
Related topics
Refilling Ink and Replacing the Maintenance Box
Solving Paper Problems
Wi-Fi Networking

Message Appears Prompting You to Reset Ink Levels
If you see a message on the LCD screen prompting you to reset the ink levels, do the following:
1. Refill all of the ink tanks or the ink tanks indicated on the LCD screen all the way to the top.

Note: Depending on the operating conditions, you may see the ink reset message even when there is
still ink in the tanks.

2. Select the colors that you refilled on the LCD screen.
3. Press the start button, and follow the instructions on the LCD screen to reset the ink levels.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it
estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may
generate inaccurate messages if the ink tanks are not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below
the lower line. Continued use of the product when the ink level is below the lower line on the tank could
damage the product.

Parent topic: Solving Problems

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.
5. Select Nozzle Check and press the OK button.
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6. Press the start button.
The nozzle check pattern is printed.

7. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check other solutions or try uninstalling and reinstalling your printer software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check other solutions. If they do not

work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Alignment
Print Head Cleaning
Power Cleaning
Uninstall Your Product Software
Related references
Where to Get Help (Latin America)
Related topics
Loading Paper

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.
1. Press the home button, if necessary.
2. Select Settings and press the OK button.
3. Select Restore Default Settings and press the OK button.
4. Select one of these options and press the OK button:

• Network Settings: Resets all network settings.
• Copy Settings: Resets all copy settings.
• Scan Settings: Resets all scan settings.
• Clear All Data and Settings: Resets all settings.
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You see a confirmation screen.
5. Press the OK button to reset the selected settings. (Press the stop button if you want to cancel the

operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Product Does Not Turn On or Off
Noise After Filling the Ink
Software Installation Problems
Control Panel Setup Problems
Parent topic: Solving Problems

Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:
• If you cannot turn on your product, make sure the power cord is securely connected and hold down

the power button a little longer.
• If your product is connected using a USB cable, make sure the USB cable is securely connected to the

product and the computer.
• If you are connecting over a network, make sure your product is set up properly on the network.
• If your product does not turn on automatically, make sure the Auto Power On setting is enabled on

the LCD screen (Settings > Printer Setup > Auto Power On).
• Make sure the power light is off before you turn on the power.
• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off

your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Note: If Auto Power On is enabled, it may take longer to turn off the power.

Parent topic: Solving Setup Problems
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Noise After Filling the Ink
If you hear noises from your product after filling the ink tanks with ink, check these explanations:
• The first time you fill the tanks with ink, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 20 minutes, turn off your product. Turn it back on and check to see if charging is
still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related references
Where to Get Help (Latin America)

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• For Mac, make sure your product is shown in the printer list. Click System Preferences or System
Settings > Printers & Scanners or Print & Fax. If the printer name is not displayed, add the printer.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

• If you are printing over a network, make sure your product is set up properly on the network.
• If the USB cable is not recognized, try using a different USB cable.
Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
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Mac System Requirements
Related topics
Wi-Fi Networking

Control Panel Setup Problems
If you have problems setting up the control panel, try these solutions:
• To view LCD screen text in a different language, select a different language setting for the panel.
• To adjust the position of the control panel, carefully raise or lower it.
Parent topic: Solving Setup Problems
Related tasks
Changing LCD Screen Language

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac Printer Window
Wireless Network Connection is Unstable on a Mac
Cannot Print Over a Network
Cannot Scan Over a Network
Parent topic: Solving Problems
Related tasks
Printing a Network Status Sheet
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Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.
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• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• Turn off the devices you want to connect to the network. Wait for about 10 seconds and then turn on
the devices in the following order: wireless router, computer or smart device, and then your product.
Move your product and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

• If the IP address assigned to the product is 169.254.XXX.XXX and the subnet mask is 255.255.0.0,
the IP address may not be assigned correctly. Check the IP address and the subnet mask assigned to
the product. Restart the wireless router or reset the network settings for the product.

• If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the
maximum number of devices connected to your product (8). Print a network status sheet or access
Web Config on the browser for your device and check the number of connected devices. If 8 devices
are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of
that device. If fewer than 8 devices are connected, check the accuracy of your other network settings,
move your device closer to your product, and try connecting again.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi Direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

Parent topic: Solving Network Problems
Related concepts
Wi-Fi Direct Mode Setup
Related references
Status Icon Information
Related tasks
Printing a Network Status Sheet
Printing a Network Connection Report
Disabling Wi-Fi Features
Related topics
Wi-Fi Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify the connection using your

product control panel.
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• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

• Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:

1. Reset your product's network settings to their factory defaults.
2. Windows only: Uninstall your product software.
3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Printing a Network Connection Report
Related topics
Wi-Fi Networking



200

Product Does Not Appear in Mac Printer Window
If your product does not appear in the Mac printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear

on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems
Related references
Status Icon Information
Related tasks
Uninstalling Product Software - Mac

Wireless Network Connection is Unstable on a Mac
If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network
interference between your product and your Mac.
If you cannot connect to your product over the wireless network or the connection becomes unstable,
move the device connected to your Mac USB 3.0 port further away from your Mac.
Parent topic: Solving Network Problems

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Make sure that the latest version of your product's Epson printer driver is installed. If a genuine Epson

printer driver is not installed, the available functions are limited. To check if a genuine Epson printer
driver is installed on your computer, do the following:
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Windows: Select Control Panel > View devices and printers (Printers, Printers and Faxes), do
the following to open the print server properties window:
• Windows 11/Windows 10/Windows 8.x/Windows 7/Windows Server 2022/Windows Server

2019/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server
2008 R2: Click the printer icon, and then click Print server properties at the top of the window.

• Windows Vista/Windows Server 2008: Right-click on the Printers folder, and then click Run as
administrator > Server Properties.

• Windows Server 2003 R2/Windows Server 2003: From the File menu, select Server Properties.
Click the Drivers tab. If your printer name is displayed in the list, a genuine Epson printer driver is
installed on your computer.
macOS 10.12.x to 13.x: Select System Preferences from the Apple menu > Printers & Scanners,
Print & Scan, or Print & Fax, and select the printer. Click Options & Supplies. If the Options and
Utility tabs are displayed in the window, a genuine Epson printer driver is installed on your computer.

• Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

• Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point. Avoid placing your product near a microwave oven,
cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.
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• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi connection icon is not
lit or does not appear on the product's LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.

• Check your product's connection status by opening the EPSON Status Monitor 3 (Windows) or
EPSON Status Monitor (Mac) on your computer. If the remaining ink levels are displayed, a
connection has been successfully established between your computer and your product.

• If you are printing a large data size image, the computer may run out of memory. Print the image at a
lower resolution or a smaller size.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related references
Cannot Scan Over a Network
Related tasks
Printing a Network Status Sheet
Printing a Network Connection Report
Related topics
Wi-Fi Networking

Cannot Scan Over a Network
If you have problems scanning over a network, try these solutions:
• If you cannot scan from your product control panel, make sure you restarted your computer after

installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Check the scanning setting assigned in Epson Event Manager.
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• If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few
seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan 2 again.

• Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

Windows 11: Click , then search for Epson Scan 2 Utility and select it. Make sure your product is
selected. If necessary, select the Other tab and click Reset.

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure your product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen, select EPSON, and select Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Parent topic: Solving Network Problems
Related topics
Starting a Scan
Wi-Fi Networking

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Copies Have Incorrect or Faint Colors
Position, Size, or Margins of Copies are Incorrect
Parent topic: Solving Problems



204

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Copies Have Incorrect or Faint Colors
If your copies have incorrect, uneven, smeared, or faint colors, try these solutions:
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Do not press too hard on the original when you copy from the scanner glass.
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Wipe any dirt or dust off of your originals.
• If the colors are smeared, try lowering the copy density setting on the LCD screen.
• Make sure your paper is not curled.
• When vertical banding appears or the paper is smeared, clean the paper path.
• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the

correct direction and slide the edge guides to the edges of the paper.
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• If the back of the original appears in your printout, place a piece of black paper on the back of the
original and copy it again. You can also try lowering the Density setting.

Parent topic: Solving Copying Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related tasks
Cleaning Your Product

Position, Size, or Margins of Copies are Incorrect
If the position, size, or margins of your copies are incorrect, try these solutions:
• When placing originals on the scanner glass, make sure the original is placed correctly for scanning.

Align the corner of the original with the corner indicated by the symbol on the scanner glass. If
necessary, move the original away from the edges of the scanner glass slightly.

• Clean the scanner glass.
• Make sure the paper is loaded in the correct direction.
• Select the appropriate Original Size in the copy settings on the LCD screen.
Parent topic: Solving Copying Problems
Related references
Copying Options
Related tasks
Cleaning Your Product
Related topics
Placing Originals on the Product
Loading Paper

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems Inside the Product
Paper Ejection Problems
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Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• Place the product on a flat surface.
• Operate the product in the recommended environmental conditions.
• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feeder.

Slide the edge guides against the edge of the paper, making sure that the paper stack is not above the
arrow mark on the edge guides.

• Load paper in the correct direction and slide the edge guide against the edge of the paper.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If multiple pages feed at once, try loading one sheet at a time.
• If multiple pages feed at once, the paper may be moist or damp. Load new paper.
• If multiple pages feed at once during manual 2-sided printing, remove any paper from the product and

reduce the number of sheets to half or less before reloading paper.
• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not load

more than the recommended number of sheets.
• Do not load more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check

the paper packaging or contact the manufacturer to confirm the paper specifications.
• Make sure the paper size and paper type settings match the actual paper size and type loaded in the

printer.
• Try cleaning the paper path.
• Do not place objects on the feeder guard.
• If paper feeds at a slant, load paper in the correct direction and slide the edge guides against the edge

of the paper.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the rear paper feeder printable side up.
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• Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems
Related concepts
Print Head Cleaning
Related references
Paper Jam Problems Inside the Product
Paper Specifications
Paper Loading Capacity
Related tasks
Cleaning the Paper Guide
Cleaning Your Product
Related topics
Loading Paper

Paper Jam Problems Inside the Product
If you see a message that paper has jammed inside the product, follow the steps here.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the
product starts operating, it may cause an injury. Do not touch any protruding parts inside the product. Be
careful not to trap your hand or fingers when opening or closing the inner cover.

Caution: Remove the jammed paper carefully. Removing the paper forcefully may cause damage to the
printer. When removing jammed paper, avoid tilting the printer, placing the printer vertically, or turning
the printer upside down; otherwise ink may leak.

1. Cancel the print job, if necessary.
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2. Remove any jammed paper from the rear paper feeder.

3. Raise the control panel.
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4. Open the inner cover and remove any jammed paper inside.

Caution: Be careful not to trap your hand or fingers when opening or closing the inner cover. Do not
touch any parts inside the product. Doing so may cause a malfunction.

5. Close the inner cover.
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6. Lower the control panel.

7. Follow the prompts on the LCD screen to clear any error messages.
Parent topic: Solving Paper Problems
Related tasks
Cancelling Printing Using a Product Button
Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper falls from the output tray, extend the paper stopper.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel
Related tasks
Cancelling Printing Using a Product Button
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Related topics
Loading Paper

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• Make sure there are no errors or paper jams in the product.
• There may a problem with the printer's status. Click EPSON Status Monitor 3 on the printer driver's

Maintenance tab, and then check the printer status. If EPSON Status Monitor 3 is disabled, click
Extended Settings on the Maintenance tab, and then select Enable EPSON Status Monitor 3.

• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

• If your computer is connected using a USB cable, try a different USB port on your computer or a
different cable.

• Make sure the printer status is not offline or pending.
• Make sure you are using the Epson printer driver for your product or the available functions are

limited.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
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• Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

• In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

• In Windows, do one of the following to open the Epson Printer Connection Checker and follow the on-
screen instructions to check the connection status:

• Windows 11: Click , then search for Epson Printer Connection Checker and select it.

• Windows 10: Click and select Epson Software > Epson Printer Connection Checker.
• Windows 8.x: Navigate to the Apps screen and select the Epson Printer Connection Checker

icon.

• Windows 7: Click and select All Programs > Epson Software > Epson Printer Connection
Checker.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
• Make sure your product is selected as the printer in your printing program.
• Make sure EPSON Status Monitor 3 is enabled to perform manual 2-sided printing (Windows). Manual

2-sided printing may not be available when the printer is accessed over a network or is used as a
shared printer.

• You can try to clear the problem by updating the product software to the latest version. If the problem
persists, try uninstalling and reinstalling the printer driver.

Parent topic: Solving Problems Printing from a Computer
Related references
Product Status Messages
Windows System Requirements
Mac System Requirements
Related tasks
Running a Product Check
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Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 11: Click , search for Settings and select it. Select Bluetooth & devices > Printers
& scanners. Select your product name and select Printing preferences.

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• On a Mac, make sure you download and install the Epson printer driver.
• Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
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• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

• If you are printing over a wireless network, factors such as interference, network traffic, or weak signal
strength may affect your printing speed.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

• Windows: Select Printing preferences, click the More Options tab, and make sure the
Bidirectional printing setting is enabled.

• Mac: Select System Preferences or System Settings, select Printers & Scanners, and select your
product. Select Options & Supplies, select Options (or Driver), and enable the Bidirectional
printing setting.

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.
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Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer
Related references
Paper Source Settings Options
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel
Windows System Requirements
Mac System Requirements
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
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Parent topic: Solving Problems
Related tasks
Using AirPrint

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
• You may need to refill the ink. Visually check the ink levels.
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• Make sure your product is on a flat surface and operating in the recommended environmental
conditions or multiple sheets of paper may be fed at the same time.

Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
• When placing originals on the scanner glass, align the corner of the original with the corner indicated

by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.
• Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area

may extend to include the dust or stains.
• Load paper in the correct direction and slide the edge guides against the edges of the paper.
• Select the appropriate original size in the copy settings.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
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Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper
Placing Originals on the Product

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
• Make sure you are printing on a compatible borderless paper type and size.

Note: For custom paper sizes, make sure you select a supported borderless page width.

• Windows: Make sure you selected the Borderless setting in your printer software.
• Mac: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in

your printer software.
• Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless

prints.
• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement

may not be enough to cover the paper.
• Make sure you have stored the paper correctly. Paper can expand or contract if it is not stored

properly. See the instructions that came with your paper for storage instructions.
Parent topic: Solving Page Layout and Content Problems
Related references
Print Options - Mac
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Borderless Paper Type Compatibility
Related tasks
Selecting Basic Print Settings - Windows
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Selecting Basic Print Settings - Mac
Selecting Extended Settings - Windows
Selecting Printing Preferences - Mac

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• On a Mac, cancel any paused print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If incorrect characters still appear in your prints, try connecting your product using a different cable.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
• Make sure you are using the printer software for this product. Check the product name at the top of the

driver window.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Printing Your Document or Photo - Mac

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
• Slide the edge guides against the edges of the paper.
• Clean the scanner glass and document cover.
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• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner
glass.

• Make sure you selected the correct margins for your paper size in your printing program.
• Be sure to select the appropriate original size setting for your original in the copy settings.
• If the image is slightly enlarged and cropped during borderless printing, change the Expansion

setting.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Selecting Page Setup Settings - Mac
Cleaning Your Product
Related topics
Loading Paper
Placing Originals on the Product

Slanted Printout
If your printouts are slanted, try these solutions:
• Make sure the paper is loaded in the correct direction.
• Make sure your paper meets the specifications for your product.
• Do not load more than the recommended number of sheets.
• Slide the edge guide against the edge of the paper.
• Make sure the paper type setting matches the type of paper you loaded.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
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• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems
Related tasks
Using AirPrint

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
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• Turn off any high speed settings in your product software.
• Align the print head.
• Adjust the print quality in the product software.
• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the

correct direction and slide the edge guides to the edges of the paper.
• If you continue to see horizontal bands or streaks in your printouts after cleaning the print head and

adjusting the print quality, make print quality adjustments for each paper type.
• Clean any dust or dirt from your originals.
• When vertical banding appears or the paper is smeared, clean the paper path.
• You may need to refill the ink. Visually check the ink levels.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac
Refilling the Ink Tanks
Related topics
Loading Paper
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Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Slide the edge guides to the edges of the paper.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Place a piece of black paper on the back of the original and copy it again.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Do not load more than the recommended number of sheets. For plain paper, do not load above the

line indicated by the triangle symbol on the edge guide.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, make sure you select the appropriate settings.
• When manually printing 2-sided, make sure the ink is completely dry before loading the paper.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Dry printouts completely before filing or displaying them. When drying printouts, avoid direct sunlight,

do not use a dryer, and do not touch the printed side of the paper.
• Do not stack printouts immediately after printing.
• Turn off any high speed settings in your product software.
• When vertical banding appears or the paper is smeared, clean the paper path.
• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the

correct direction and slide the edge guides to the edges of the paper.
• If you printed on the wrong side of photo paper, clean the paper path.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density
and/or ink drying time settings.

• Lower the copy density setting on the product control panel.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
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• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• Do not press too hard on the original or the document cover when you are scanning originals on the

scanner glass.
• Clean the scanner glass.
• Use the ink before the date printed on the package.
• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to

the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has
improved.

• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Compatible Epson Papers
Paper Specifications
Related tasks
Checking Ink Levels on Your Product
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Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Refilling the Ink Tanks
Cleaning the Paper Guide
Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the initial ink charging is complete.
• The ink levels may be low. Visually check the ink levels.
• If any ink levels are below the lower line, refill the ink tanks.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Adjust the print quality in the product software.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to
the upper lines and then run the Power Cleaning utility to replace the ink inside the ink tubes. After
running the utility, run a nozzle check to see if print quality has improved.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
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Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Related tasks
Refilling the Ink Tanks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac
Cleaning the Paper Guide
Related topics
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.
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Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the paper type setting matches the paper you loaded.
• Make sure the Grayscale setting is not selected in your printer software.
• If you selected Standard-Vivid (Windows) or Normal-Vivid (Mac) as the quality setting in the printer

software, try selecting Standard (Windows) or Normal (Mac) instead.
• Select EPSON Standard as the Color Mode (Windows) or Mode (Mac) setting in the printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to

the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has
improved.

• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors
may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.
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• Select Custom as the Color Correction setting on the More Options tab of the printer software, then
click Advanced. Try changing the Scene Correction setting to something other than Automatic. If
changing that setting does not work, change the Color Management setting to any color correction
method other than PhotoEnhance.

• If you are using a Mac, select ColorSync from the Color Matching menu of the driver.
• For best results, use genuine Epson paper.
• Remove any dust or dirt on the originals and clean the scanner glass.
• Do not press with too much force on the original or the document cover.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

• If you are copying an original, lower the Density setting.
• Colors may differ if you are viewing the image on a computer or device with a high-resolution display.

Make sure to avoid direct sunlight when confirming the image on the display.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Power Cleaning
Related references
Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printing Software
Compatible Epson Papers
Related tasks
Checking Ink Levels on Your Product
Refilling the Ink Tanks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows
Managing Color - Mac
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Related topics
Loading Paper

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Note: For solutions when using the Epson ScanSmart software, see the Epson ScanSmart help utility.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Scanning is Slow
Cannot Send Scans to a Cloud Service
Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control

panel.
• Make sure the power cord is connected and the product is turned on.
• Try scanning at a lower resolution or increase the free space on the computer's hard disk. Scanning

stops if the total data size reaches the limit.
• Use the Epson Scan 2 Utility on your computer to reset the scanner software settings. If resetting the

settings does not solve the problem, uninstall and reinstall the scanner software.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
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Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If you scan at a high resolution over a network, a communication error may occur. Lower the

resolution.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:

Windows 11: Click , search for Epson Scan 2 Utility and select it. Make sure the correct product
is selected. If necessary, select the Other tab and click Reset.

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure the correct product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct
product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson Scan
2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both
versions and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Scan Resolution Guidelines
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Related topics
Starting a Scan

Scanning is Slow
If scanning becomes slow, try these solutions:
• Scan your original at a lower resolution, if possible.
• Make sure your system meets the requirements for your operating system. If you are scanning a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

• If you are scanning over a wireless network, factors such as interference, network traffic, or weak
signal strength may affect your scanning speed.

Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Scan Resolution Guidelines
Related references
Windows System Requirements
Mac System Requirements

Cannot Send Scans to a Cloud Service
If you cannot send a scan to a cloud service, try these solutions:
• Make sure your computer is connected to the internet.
• Make sure the login information you entered for the cloud service is correct.
• Make sure the cloud service is not down for system maintenance. Check the cloud service website for

more information.
Parent topic: Solving Scanning Problems
Related tasks
Sending a Scan to a Cloud Service
Related topics
Wi-Fi Networking
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Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Note: For solutions when using the Epson ScanSmart software, see the Epson ScanSmart help utility.

Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Scanned Image Quality Problems
Characters are Not Recognized During Conversion to Editable Text (OCR)
Image Colors are Patchy at the Edges
Ripple Patterns Appear in an Image
Scanned Image Edges are Cropped
Resetting the Epson Scan 2 Settings
Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If the Image Type setting is Black & White, adjust the Threshold and scan again.
• Remove any lint or dirt from your original.
• Clean the scanner glass.
• Do not press on the original or the document cover with too much force.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Related tasks
Cleaning Your Product
Related topics
Placing Originals on the Product
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Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.
• Remove any dust or dirt that may have adhered to your original.
• Do not press with too much force on the original or the document cover.
• Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the
cloth, if necessary. Paper towels are not recommended.
Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product
Related topics
Placing Originals on the Product

Scanned Image Quality Problems
If you encounter quality problems with your scanned image, try these solutions:
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Image is Distorted or Blurry
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the

scanner glass.
• Do not move your original or your product during scanning.
• Do not press on the document cover or the original with too much force.
• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable

surface that extends beyond its base in all directions.
• Adjust these Epson Scan 2 or Epson ScanSmart settings (if available) and try scanning again:

• Increase the Resolution setting.
• If the Image Type setting is Black & White, adjust the Threshold setting.
• If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
• If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is

Color or Grayscale, change the Text Enhancement setting to High.

Image is Too Dark
• Make sure you select the correct Image Type for your original.
• If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.

Back of Original Image Appears in Scanned Image
• Place a piece of black paper on the back of the original and scan it again.
• Lower the copy density setting.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Make sure you select the correct Image Type for your original.
• Select the Advanced Settings tab and adjust the Brightness setting.
• If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to

Color or Grayscale, change the Text Enhancement setting to High.

Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
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Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
Remove any dust or dirt from your originals and clean the scanner glass. Do not press with too much
force on the original or document cover.
To adjust the colors in your scanned image, adjust these Epson Scan 2 or Epson ScanSmart settings (if
available) and try scanning again:
• Make sure you select the correct Image Type for your original.
• If the Image Type setting is Color or Grayscale, adjust the Contrast setting.
• If the Image Type setting is Black & White or Grayscale, adjust the Color Enhance setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Related tasks
Cleaning Your Product
Changing the Scan Settings

Characters are Not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:
• Make sure your original is loaded straight on your product.
• Use an original with clear text.
• When saving scanned images as Searchable PDFs, make sure the correct OCR language is selected.
• Adjust the following Epson Scan 2 or Epson ScanSmart settings if available, and try scanning again:

• On the Main Settings tab, make sure you select the correct Image Type for your original.
• On the Main Settings tab, set the Resolution between 200 and 600 dpi.
• On the Advanced Settings tab, select Text Enhancement and choose a setting.

Note: The Text Enhancement setting depends on the selected Image Type.

• If the Image Type is set to Black & White, adjust the Threshold setting on the Advanced Settings
tab. (The Image Option must be set to None.)

Parent topic: Solving Scanned Image Quality Problems
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Related tasks
Scanning a Document in Epson ScanSmart
Scanning in Epson Scan 2
Related topics
Placing Originals on the Product

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
• Place the original at a slightly different angle.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
In the Epson Scan 2 or Epson ScanSmart settings, set the Edge Fill setting to None.
When scanning using Epson ScanSmart and placing multiple originals on the scanner glass, make sure
there is a gap of at least 0.8 in. (20 mm) between the originals.
Parent topic: Solving Scanned Image Quality Problems
Related topics
Placing Originals on the Product
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Resetting the Epson Scan 2 Settings
If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.
1. Do one of the following to start the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click > EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-
install it.

Parent topic: Solving Scanned Image Quality Problems

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Close any open programs or applications.
3. Disconnect any interface cables.
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4. Do one of the following:

• Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

• Windows 10: Click and select (Settings) > Apps or System > Apps & features. Then
select the program you want to uninstall and select Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
5. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:

• Windows 11/Windows 10/8.x: Select Epson Event Manager and click Uninstall.
• Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and

Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

6. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
• Windows 11/Windows 10: Select Epson Scan 2 and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson Scan 2 and click Uninstall/Change.

7. Do one of the following to uninstall Epson ScanSmart, then follow any on-screen instructions:
• Windows 11/Windows 10: Select Epson ScanSmart and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson ScanSmart and click

Uninstall/Change.
8. Restart your computer, then see the Start Here sheet to re-install your software.
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Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit latin.epson.com/support and select your product.
2. Click Downloads.
3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help (Latin America)
If you need additional help with your Epson product, contact Epson.
Epson provides these technical support services:

https://latin.epson.com/support
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Internet Support
Visit Epson's support website at latin.epson.com/support for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:

Country Telephone
Argentina (54 11) 5167-0300

0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627

Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: (57 1) 602-4751

Other cities: 01-8000-915235
Costa Rica 800-377-6627
Dominican Republic* 1-888-760-0068
Ecuador* 1-800-000-044
El Salvador* 800-6570
Guatemala* 1-800-835-0358

https://latin.epson.com/support


241

Country Telephone
Mexico Mexico City: (52 55) 1323-2052

Other cities: 800-087-1080
Nicaragua* 00-1-800-226-0368
Panama* 00-800-052-1376
Paraguay 009-800-521-0019
Peru Lima: (51 1) 418-0210

Other cities: 0800-10126
Uruguay 00040-5210067

* Contact your local phone company to call this toll-free number from a mobile phone.
If your country does not appear in the list, contact the sales office in the nearest country. Toll or long
distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.
Parent topic: Solving Problems

https://latin.epson.com
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Technical Specifications
These sections list the technical specifications for your product.
Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Ink Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 11
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista

Note: For the latest product software available for your operating system, visit the Epson support site at
latin.epson.com/support, select your product, and select Downloads.

Parent topic: Technical Specifications

https://latin.epson.com/support
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Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 13.x
• macOS 12.x
• macOS 11.x
• macOS 10.15.x
• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x

Note: Mac OS may not support some applications and features; the UNIX File System (UFS) for Mac
OS is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
latin.epson.com/support, select your product, and select Downloads.

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

https://latin.epson.com/support
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Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 356 mm])
Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
8.5 × 13 inches (216 × 330 mm)
3.5 × 5 inches (89 × 127 mm)
4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
Executive (7.25 × 10.5 inches [184 × 267 mm])
Half Letter (5.5 × 8.5 inches [140 × 216 mm])
User-defined size paper from 2.12 × 3.39 inches (54 × 86 mm) to 8.5
× 47.24 inches (215.9 × 1200 mm)

Note: Printing on user-defined paper sizes is available only when
printing from a computer.

Paper types Plain paper

Note: Your product also supports compatible papers distributed by
Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Note: Even when the paper weight is within this range, the paper
may not feed in the printer or the print quality may decline depending
on the paper properties or quality.
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Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain bond paper
Weight 20 lb (75 g/m2) to 27 lb (100 g/m2)

Note: Even when the paper weight is within this range, the paper
may not feed in the printer or the print quality may decline depending
on the paper properties or quality.

Parent topic: Technical Specifications
Related references
Compatible Epson Papers

Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets - borders
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1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.61 inches (41 mm) minimum
3 Reduced print quality area/bottom: 1.46 inches (37 mm) minimum

Single sheets - borderless

1 Reduced print quality area/top: 1.73 inches (44 mm) minimum
2 Reduced print quality area/bottom: 1.57 inches (40 mm) minimum

Envelopes

1 Right/left margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.12 inch (3 mm) minimum
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3 Reduced print quality area/right: 0.71 inch (18 mm) minimum
4 Reduced print quality area/left: 1.61 inches (41 mm) minimum

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed, color
Photoelectric device CIS
Effective pixels 10200 × 14040 pixels (1200 dpi)
Document size Maximum: 8.5 × 11.7 inches (216 × 297 mm)

Scanner glass: US letter or A4
Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)
Output resolution 50 to 9600 dpi in 1 dpi increments
Image data Color:

48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color external)
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black and white:
16 bits per pixel internal
1 bit per pixel external

Light source LED

Parent topic: Technical Specifications
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Ink Specifications
Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottles that are used for initial product setup have a lower yield due to the ink charging process.
This process is carried out the first time you turn on the printer and guarantees better performance.
Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and
temperature. Do not load paper before refilling the ink tanks.
Check the ink levels in your product frequently, and refill the ink tanks if necessary.

Color Black, Cyan, Magenta, Yellow
Ink life Opened package: Use as soon as possible

Unopened package: Use before the date on the package has
expired

Temperature Storage: –22 to 104 °F (–30 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C)

Parent topic: Technical Specifications
Related references
Ink Bottle and Maintenance Box Part Numbers

Dimension Specifications
Height Stored: 7.0 inches (179 mm)

Printing: 10.0 inches (253 mm)
Width Stored: 14.8 inches (375 mm)

Printing: 14.8 inches (375 mm)
Depth Stored: 13.7 inches (347 mm)

Printing: 22.8 inches (578 mm)
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Weight
(without ink or power cord)

Approximately 9.5 lb (4.3 kg)

Parent topic: Technical Specifications

Electrical Specifications
Note: Check the label on the product for its voltage.

Power supply rating 100 to 240 V
Rated frequency range 50 to 60 Hz
Rated current 0.4 to 0.2 A
Power consumption
(with USB connection)

Standalone copying: Approximately 12 W (ISO/IEC24712)
Ready mode: Approximately 7.1 W
Sleep mode: Approximately 0.8 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operating: 20 to 80% RH
Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (Device Class for computers; USB 3.0 cables are not

supported)
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Parent topic: Technical Specifications

Network Interface Specifications
Standard IEEE 802.11 b/g/n; IEEE 802.11n available only on the 20 MHz

channel
Security WEP (64/128 bit); not supported for Wi-Fi Direct mode

WPA2-PSK (AES); complies with WPA2 with support for
WPA/WPA2 Personal
WPA3-SAE (AES); not supported for Wi-Fi Direct mode

Frequency range 2.4 GHz
Communication mode Infrastructure mode

Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b

Note: Infrastructure and Wi-Fi Direct modes can be used
simultaneously.

Security Protocol SSL/TLS: HTTPS Server/Client, IPPS

Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC Part 15 Subpart B Class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN ICES-3 (B)/NMB-3 (B)

This equipment contains the following wireless module:
• Manufacturer: Seiko Epson Corporation.
• Type: J26H006
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
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cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.
Important Safety Instructions
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Product Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions
Administrator Password Instructions
Parent topic: Notices

General Product Safety Instructions
• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Do not use the cord with any other equipment.

Using another cord or using the provided cord with other equipment may cause fires or shock.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system

that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,

crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
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ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.
• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not

operate properly if it is tilted or at an angle.
• Allow space behind the product for the cables, and space above the product so that you can fully raise

the document cover.
• Leave enough space in front of the product for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place or store the product outdoors.
• Do not place the product near excessive heat sources or in direct sunlight.
• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers

or the base units of cordless telephones.
• Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your

product's radio waves from affecting the operation of the pacemaker.
• When connecting the product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not sit or lean on the product. Do not place heavy objects on the product.
• Do not touch the flat white cable or ink tubes inside the product.
• Do not move the print head by hand; this may damage the product.
• Do not put your hands inside the product while it is printing.
• Do not spill liquid on the product or use the product with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may

cause fire.
• Do not press too hard on the scanner glass when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any

other functions.
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• Be careful not to trap your fingers when closing the document cover or inner cover.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the

product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• Prolonged use of the product when the ink level is below the lower line could damage the product. Fill
the ink tank to the upper line while the product is not operating. To display the correct ink level
estimates, reset the ink level after filling the tank.

• Before transporting the product, make sure that the print head is in the home (far right) position.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;

otherwise, ink may leak.
• For models with only internal ink waste pads: Some users that print extensively may receive a

message informing them that the ink waste pad is full. The duration of the pad depends on the amount
of use and usage conditions such as high humidity, heat or dusty conditions that require more
cleaning cycles. The Epson Status Monitor and warning light on the control panel will indicate when
the waste pad needs to be replaced. The ink pad is not a user serviceable part. Please seek service
from an Epson Authorized Service Center or consider a new printer if your printing needs have
changed or the printer has had a long period of extensive use.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson

for support.
• The LCD screen may contain a few small bright or dark spots, and may display uneven brightness.

These are normal and do not indicate that the screen is damaged in any way.
Parent topic: Important Safety Instructions
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Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Do not connect this product to the internet directly. Connect it to a network protected by a router or
firewall.
Parent topic: Important Safety Instructions

Administrator Password Instructions
You can set an administrator password to prevent unauthorized access or changes to general product
settings and network settings stored in the product when connecting to a network.
The default value of the administrator password is printed on the product's label. The label is located on
the side where the cover is opened, the back, or the bottom, depending on the product.
You must enter the default administrator password when performing the following operations:
• Updating your product's firmware from a computer or smart device
• Accessing the advanced settings in Web Config
• Using applications that can change the product's settings
You can change the administrator password from the product's control panel or Web Config. The new
password must be 8 characters or more. If you restore the product to default settings (Settings >
Restore Default Settings > Clear All Data and Settings), the administrator password resets to the
product serial number.
Parent topic: Important Safety Instructions

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television



256

reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
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arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at https://www.jamsadr.com/about/ or
by calling +1-949-224-1810 (from outside the U.S.) or 1-800-352-5267 (from within the U.S.), and under
the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and
both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The
arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court
or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the
interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or

https://www.jamsadr.com/about/
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any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the
arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP
Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be
empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator
may award you the same damages as a court could, and may award declaratory or injunctive relief only
in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted
by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of
litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award
is binding and may be entered as a judgment in any court of competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section

http://www.jamsadr.com


259

1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON®, Epson ScanSmart®, and Epson Smart Panel® are registered trademarks, the EPSON logo is a
registered logomark, and Epson ConnectTM and Remote PrintTM are trademarks of Seiko Epson
Corporation.
AmazonTM and AlexaTM are trademarks of Amazon.com, Inc. or its affiliates.
Apple, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, OS X, and Siri are trademarks of
Apple Inc., registered in the U.S. and other countries. App Store is a service mark of Apple Inc.,
registered in the U.S. and other countries.
Use of the Works with Apple badge means that an accessory has been designed to work specifically
with the technology identified in the badge and has been certified by the developer to meet Apple
performance standards.
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Google® is a registered trademark and AndroidTM, ChromebookTM, GmailTM, Google DriveTM, and Google
PlayTM are trademarks of Google LLC.
Microsoft and Windows are trademarks of the Microsoft group of companies. 
Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
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Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product enters sleep mode after a period of nonuse. You can adjust the time period before power
management begins, but increasing the time reduces the product's energy efficiency. Energy savings
can be achieved by setting the time to sleep to a shorter interval.
Parent topic: Copyright Notice
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